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Chapter 1

Introduction

Basic information regarding Interiors and Interiors plug-ins, including instal-
lation instructions and technical support details.
Table of Contents
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Entering serial number 1-2

Plug-ins 1-3

Help 1-4
Interiors Online Manual 1-4

Technical Support 1-4
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υ Introduction

Thank you for choosing Microspot Interiors, the affordable, easy to use 3D modeling ap
tion for the Macintosh®. Designed for novices as well as professionals, Microspot Interio
provides the tools you need to create realistic, 3D interior designs.

In addition to a core application suitable for viewing and manipulating existing 3D files, 
Microspot Interiors offers a plug-in architecture that makes it easy to add tools and exten
program’s functionality. Plug-ins can be palettes, tools, menu items or idlers and can be l
as the application is launched. Information about the plug-ins included is provided in this
ual.

υ Installation 

1. Insert the CD into the CD drive and double click on the CD icon on the desktop to
play its contents.

2. Now Drag the Microspot Interiors folder to your application folder:

υ Entering serial number

The first time you run Interiors you will be asked to enter your serial number.

The serial number is on the inside of the packaging. Please enter the details requested.
1-2
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υ Plug-ins

The Interiors’ plug-in architecture allows plug-ins to be used to add functionality to the a
cation in many different ways. Plug-ins may be available in more than one category:

Import Plug-ins: Plug-in functions accessed via the Import submenu in the File menu.

There are no Import plug-ins included in Interiors.

Export Plug-ins: Plug-in functions accessed via the Export submenu in the File menu.

Menu Plug-ins: Plug-in functions accessed via the Plug-in menu in the application menu b

Plug-in Palettes: Palettes provide a range of options for a specific feature. Display a palett
selecting its name from the Palettes menu.

Idler Plug-ins: Run constantly once loaded.

Plug-in Geometries: Plug-in tools to create shapes. Accessed from the Tools Palette.

Plug-in Modifiers: Plug-in tools to modify objects. Accessed from the Tools Palette.

Plug-in Renderers: Plug-in renderers accessed through the Renderer Options palette..

Microspot Preview Renderer Microspot Renderer
1-3
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υ Help

Interiors Online Manual

The online manual is included on the Interiors CD in pdf format. To access the online ma
launch Interiors and select Interiors Manual from the help menu. A table of contents will 
play, allowing you to easily navigate through manual.

υ Technical Support

You must register your product in order to receive technical support, as well as upgrade
new product information, please contact: 

Address: Microspot Limited
Concorde House
10-12 London Road
Maidstone
Kent
ME16 8QA
England

Phone: 01622-687771; International: + 44-1622-687771
FAX: 01622-690801; International: + 44-1622-690801

Email: support@microspot.co.uk
Web: www.microspot.co.uk
1-4
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Chapter 2

Tutorial

A brief introduction to some of Interiors’s features and tools.
Table of Contents
Getting Started 2-3

Launch Interio rs 2-3
The Tools Palette 2-4
Setting the Grid Options 2-4
Resize the Window 2-5
Save the Document. 2-5

Drawing the Walls of the Room 2-5
Set the Wall Options 2-6
Draw the Walls 2-6
Change to the Top View 2-10
Rotate the Grid 2-10
Save the Document 2-11

Add a Floor 2-12

Add Windows and Doors 2-13
Selecting the Windows Tool 2-13
Changing the View 2-14
Adding a Door 2-15

Add Windows and Doors 2-13
Position the Door 2-17
Add a Window 2-18
Save a View 2-23
Add Curtains 2-24
Add Furniture 2-27

Add Furniture 2-27
Grid Snapping 2-27
Add a Sofa 2-28
Use the Nudge Palette 2-29
Latching Options 2-32
Add a Fireplace 2-33
Add the Remaining Furniture 2-36

Lighting 2-38
Wall Lights 2-38
Sun Light 2-39
Lights Palette 2-40
2-1
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Colors and Textures 2-41
Add Colors 2-41
Add Textures 2-41
Adjusting Textures 2-42
Adding Textures to Objects 2-44

Add a Ceiling 2-47

Adjust Lighting 2-48

Look Around 2-49

Final Render 2-50

Export Picture or Print 2-52
Export Picture 2-52
Print 2-53
Summary 2-53

Summary 2-53
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The following tutorial takes you through the process of designing an irregularly shaped r
and placing doors, windows, furniture, accessories and lighting objects within it. Colors a
textures are then applied to the walls and furniture, and the various light settings are adju
create a realistic scene. A final render is then produced and a picture saved and/or print

Once you are familiar with the tools and methods discussed here, you can easily use th
design and make-over your own rooms, so interior design is effortless, risk free and fun!

υ Getting Started

Launch Interiors

Double-click on the Interiors icon to launch the application. A new untitled document will
play along with the Tools and Help palettes and the application menu bar:

Tools Palette

Help Palette

Menu Bar

Document Window

Document Name Document View

Document Grid

Zoom Out
Zoom In

Change View Popup Menu
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The Tools Palette

Familiarize yourself with the tools available in the Tools palette. Click on a tool (other tha
top four tools) and hold down the mouse button to display the name of that tool. Look at
Help palette for brief advice on using the selected tool.

Note: The window view may change and various palettes open according to the tool sele
When you have finished looking at the tools available, select the Arrow tool, close all pa
except for the Tools and Help palettes (by clicking on the palette’s top left corner), and s
Home View from the Change View submenu in the View menu.

Setting the Grid Options

Before beginning to design your room, you must first specify the drawing environment. G
the Options menu and ensure that there is a checkmark next to the Metric option. If there
select Metric from the menu to specify that metric units of measurement should be used

Arrow

Rectangular Marquee

4 Walls

Windows & Doors

Light Director

VR

Take Picture

Rotate

Hand

Walls

Furnishings

Sun Direction

Gravity

Print

Walkthrough

Scale Object

Viewfinder

Point Light

Spot Light

Orbit
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Select Grid Options from the Options menu set the Grid Options as shown below and cl
OK:

See Grid Options on page 3-36 for further details.

Resize the Window

If you wish to change the window size, click on the bottom right corner of the window an
with the mouse button held down, drag to make the window smaller or larger.

Note: The smaller the window size the faster the view is rendered.

Save the Document.

Select Save from the file menu to save the document. In the dialog that displays, specify
tion to save the file and give it the name Tutorial A.

υ Drawing the Walls of the Room

We are going to draw a room that includes a chimney breast and bay window. To draw a 
gular room with just four walls you would use the 4 Walls tool, to draw this less regular r
we will use the Walls tool:
2-5
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Set the Wall Options

Hold down the Option key (alt/ ) and click on the Walls tool to display the Wall Options d
log. Enter 100 as the Wall thickness and 2300 as the Wall height. These are the default s
that will be used for any walls drawn until these settings are changed again. Click OK.

Draw the Walls

Below is a plan showing the dimensions in millimeters of the room we are going to draw

1. Select the Walls tool in the Tools palette. The document view changes to an ortho
plan view as this is the easiest view to use when drawing walls.

4000mm

1500mm

500mm

1500mm

500mm

1500mm

750mm

1000mm
2000mm

1000mm

1250mm

4500mm
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See Camera on page D-28 for further details.

2. Click towards the top left of the grid then move the cursor to the right to draw the 
wall. The wall is shown as you move the cursor. Constraining lines will display as w
can only be drawn parallel to the grid.

3. When you think the wall is about the right length, click again. The Edit options dia
will display. The height and thickness of the wall are determined by the values you
entered in the Wall options dialog. Enter a value of 4000 in the Length field and cl
OK.
2-7
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4. The first wall is drawn on the grid. Move the cursor down to draw the second wall. 
straining lines will display as walls can only be drawn at right angles to each othe

5. Click again to mark the approximate position of the end of the second section of w
The Edit options dialog displays again. Enter 1500 as the Length and click OK.

Continue in this way to draw the remaining walls referring to the plan shown at the
beginning of this section for the wall measurements.

Note the following:

• If you make any errors press the Delete key () to undo the last wall section drawn

• To avoid displaying the Edit Options dialog hold down the Option key (alt/) when 
clicking to mark the end point of a wall.
2-8
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• When you are drawing a wall you can easily see when the end of the wall aligns
another wall as an alignment line will display and the cursor changes to a hollow
cross:

6. When you have drawn the final wall click Done in the Edit Options dialog.
2-9
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7. The view will return to the view displayed prior to the selection of the Walls tool. T
walls will be drawn as specified and placed in the centre of the grid.

Note: If you forget to click Done in the Edit Options dialog when you have drawn the fina
wall, press the Delete key ( ) to delete the last wall, and then draw it again.

Change to the Top View

Select Top View from the View popup menu at the bottom of the document window, or fr
the Change View submenu in the View menu, to display a top view of the document:

Rotate the Grid

Select the Rotate tool in the Tools palette, click on the grid and drag while holding down
mouse button. This allows you to rotate the grid so that you can look at the room you ha
drawn.

Note: Hold down the Shift key ( ) when rotating the grid to constrain it to its initial plane.
2-10
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Return to the Home View by selecting its name in the View popup menu at the bottom of
document window or from the Change View submenu in the View menu.

See Manipulating The Grid on page 4-10 for further details.

Save the Document

Select Save from the File menu or press Command-S (-S/ -S) to save the document.
2-11
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υ Add a Floor

1. With the Arrow or Rotate tool selected click on a wall to select it

Note: When an object is selected it is surrounded by a bounding frame with handle
the points where the bounding lines intersect. (As you are inside the room, the bo
ing frame may not be visible in this instance.) See Select/Move on page 4-4 for furthe
details.

2. Choose Floors from the Plug-in menu.

3. A floor will be added to the room:

Note: Floors are drawn in such a way that they can only be seen from above. If yo
rotate the grid and view the room from below, the floor will be invisible, although th
floor object is still present.

Save the document.
2-12
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υ Add Windows and Doors

Selecting the Windows Tool

Click on the Windows and Doors tool in the Tools palette.

The Windows and Doors palettes and the NaviCam palette will display. Click on the title b
a palette and drag, holding down the mouse button, to reposition it.

The window view will change to show a view from the middle of the room. The camera is
placed inside the room looking towards the back wall:
2-13
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Changing the View

To change the view to show the wall in which we want to place the door, we will use the
NaviCam palette:

The red square displayed in the palette, both in the height area and in the position plan,
sents the camera. The line from this square shows the camera view direction and at the
this line is the look at point or point of interest.

• In the Position Plan, click on the camera square and drag to change the position of 
camera. Click on the view direction line and drag to change the view direction.

• In the height area move the camera up or down to change the camera height or mo
view direction line to look up or down.

• If necessary, click on the Zoom button and drag up or down to zoom in or out of the s

See NaviCam on page D-23 for further details.

Height Area
Position Plan

Zoom

Position Buttons

Grid Height

Clipping Planes
2-14
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Using the above controls change the camera position and view direction so that you are
ing at the farthest end of the left wall:

Adding a Door

Click on the Doors button in the Windows and Doors dialog. The Libraries palette will op
displaying the Doors library:

See Libraries on page D-13 for further details.
2-15
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Click on a picture of a door to select it and display its name in the field at the bottom left o
palette:

Click on the Panelled Door, hold down the mouse button and drag the cursor over the le
of the room. Release the mouse button to drop the door on the wall. The door will be pla
the wall and the Windows and Doors palette will show its dimensions and position in the

Panelled Door
2-16
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Note: If the Windows and Doors palette is not visible (it may be beneath another palette)
play it by selecting its name in the Palettes menu.

Position the Door

With the door still selected, enter 200 in the field specifying the distance of the door from
right end of the wall. Press the Enter key (). Leave the other dimensions at the default or
calculated values.

Width of door
Height of door

Height above floor

Distance from rightDistance from left
end of wallend of wall
2-17
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See Windows and Doors on page D-40 for further details.

Add a Window

Use the NaviCam palette to change the view so that you are looking at the front of the ba
dow from inside the room.

Note: If the NaviCam palette is not visible, select its name from the Palettes menu to disp
2-18
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Click on the Windows button in the Windows and Doors dialog, the Libraries palette disp
the Windows library:

To find a specific window object, type its name into the Find field at the top right of the pa
In this example, type ‘simple sash’. Press the Enter key ():
2-19



  

ull 

alette 

 and 

  

 to 

 win-
(
 

The first item with a name starting with ‘simple sash’ is found. Simple Sash Window is 
selected and highlighted by a black frame around its preview icon. The selected item’s f
name displays in the Name field at the bottom right of the palette.

Drag and drop a Simple Sash Window onto the front bay wall. The Windows and Doors p
displays the window’s dimension and position information:

Resize and reposition the window by entering the values shown below into the Windows
Doors palette. Press the Enter key () after entering information in a field.

Note: When you click in one of the measurement fields in the Windows and Doors palette
enter or change the values, a black arrow shows the dimension that the field relates to.

With the window still selected, choose Duplicate from the Edit menu. A second identical
dow is placed to the left of the first. Click on the second window, hold down the Shift key ) 
and drag the window further to the left. Holding down the Shift key () constrains movement
2-20
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to the X, Y or Z axis, so the second window should remain the same height from the floo
the first. Position the second window 150mm from the left side of the bay using the Wind
and Doors palette:

Change the view to look at the left side of the bay:
2-21



  
Add a third window and reposition/resize it as below:

Change the view and place a fourth window on the opposite side of the bay:
2-22
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Save a View

Change the view using the NaviCam palette, positioning the camera near the door and l
towards the windows. Click on the button marked with a magnifying glass and drag dow
zoom out from the scene if necessary:

Select Name View from the View menu. In the Name View dialog, enter ‘From Door’ and c
OK:
2-23
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The view will be saved under this name and can be selected from the Change View pop
menu in the View menu or from the View menu at the bottom of the document window:

Save the document.

Add Curtains

Click on Tied Curtain Open in the Windows Library and drag the curtain over the wall aro
the left hand window in the front of the bay and release the mouse button to drop the cu
into the room:
2-24
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Select the arrow tool. If the view changes, select From Door in the Change View subme
the view menu to reset the view displayed. Click and drag on the left hand curtain to posi
next to the left wall of the bay. With the curtain still selected, choose Gravity from the Plu
menu to position the curtain on the floor:

Still using the arrow tool, click on the object handle at the top right of the curtain and, ho
down the mouse button, drag to resize the curtain to a suitable height and width:

See Select/Move/Scale on page 4-7 for further details.

With the curtain still selected, choose Duplicate from the Edit menu. A second pair of ide
curtains are placed to the left of the first pair. Carefully select the second pair of curtains
2-25
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clicking on the right-hand curtain, hold down the Shift key () to constrain movement to the
X, Y or Z axis, and drag to place the second pair of curtains over the right-hand window.

Using the NaviCam palette to change the view (select the NaviCam palette from the Pal
menu to display it if necessary), and the arrow tool to move and resize the objects, add c
to the side windows of the bay.

Note: If you make a mistake at any point select Undo from the Edit menu or press Comma
( -Z/ -Z) to undo the last action.

See Undo on page 3-16 for further details.

Save the document.
2-26
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υ Add Furniture

The next stage is to furnish your room.

Select the Furnishings tool in the Tools palette. The document view will change to a top 

The Furnishings palette displays and also the Nudge palette which allows you to easily 
and rotate items. Reposition the palettes on the screen as necessary.

Grid Snapping

Grid Snapping applies an invisible grid to the document to which object points can snap
enabled by default to make it easier to align objects. The distances between the nodes 
grid are determined by the value entered for the Snapping Grid Distance in the Grid Opt
dialog.
2-27
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Grid snapping is switched on and off in the options menu. As we do not need Grid Snapp
this example, select it in the Options menu to turn this option off.

See Grid Snap on page 3-35 for further details.

Add a Sofa

Click on the Chairs button in the Furnishings palette. The Libraries plug-in displays the C
library:

Find the ‘Curved Back Sofa’ by typing its name in the Find field in the Libraries palette a
pressing Enter ( ). Click on the sofa icon and hold down the mouse button, move the cu
2-28
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over the floor of the room and when the the mouse is over floor release the mouse butto
drop the sofa onto the floor:

Either select the arrow tool and click and drag on the sofa to move it, or use the Nudge 
to move it by a specified amount.

Use the Nudge Palette 

Select the sofa in the document window.

Enter a value in the Move box in the Nudge palette. The units will be millimeters as set fo
document at the beginning of the tutorial.

Click on the control buttons to choose the direction in which to move the selected object
direction relates to the current view.

Note: You will not be able to move the sofa closer or further away (when looking at a top v
as it is constrained to stay on the floor. See Lock Position on page 4-19 for more details.

Move Up

Move Down

Move Left Move Right

Move Closer Move Further Away
2-29



Position the sofa on one side of the chimney breast:

Drag and drop a second sofa onto the floor of the room:

Use the Nudge palette to rotate the sofa:

1. Select the sofa in the document window.

2. Enter a value of 180° in the Rotate box in the Nudge palette.
2-30
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3. Click on the Rotate Clockwise button to rotate the second sofa to face the first. (T
direction of rotation relates to the current view).

Note: You will not be able to rotate the sofa other than clockwise or anticlockwise (when 
ing at a top view) as it is constrained to stay on the floor. See Lock Rotation on page 4-20 for
more details.

Rotate Up

Rotate Down

Rotate Left Rotate Right

Rotate Anticlockwise Rotate Clockwise
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Snapping Options

From the Palettes menu, select the Cursor Options palette. Set up the dialog as below t
close the palette.

Snapping is the alignment of points with other points. When positioning objects, snappin
lines will display (and sounds may play) when the snapping points of the selected objec
aligned or snapped to the snapping points of unselected objects. See Cursor Options on page 
D-11 for more details.

With the arrow tool selected, click on the second sofa and drag it until snapping lines disp
show that it is directly opposite the first sofa. Drag the sofa along the snapping lines to po
it on the opposite side of the chimney breast to the first sofa. Release the mouse button
2-32
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Add a Fireplace

Select Misc Furniture from the Display menu in the Libraries palette. A library of miscella
neous furniture items displays:

Find the Fire Place and drag and drop it onto the right wall of the room. (Ensure that the mouse 
is over the walls rather than the floor before releasing the mouse button.) As the fireplace was 
dropped onto the wall, it will be positioned against the wall:

With the fireplace still selected, choose Gravity from the Plug-in menu to position the fire
on the floor.
2-33
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Open the Info Palette by selecting Info from the Palettes menu:

Select the fireplace again if necessary, 

When you select any item the Info palette gives you vital information about that object. T
top few items are Name, Position, Size and the rotations locks. Notice also that the indiv
items have letters to indicate the X, Y or Z coordinates but also to make things easier th
color coded. If you select an object the lines that make up the bounding box use the sam
coding as the Info palette size colors. 

In this case we want to change the width of the fireplace from 1512 to 1500. Type 1500 
field which colors match the bounding box in the Info Palette and press the Enter key (). 
The fireplace is resized so that it is 1500mm long, which is the same size as the width o
chimney breast.

Moving items is also controlled from the Info Palette. You will have noticed that there are 
colored lines on the grid which give the X, Y or Z directions from the origin which is the ce
of the grid. The position of the object is shown in the Info Palette as the coordinates of th
ter of the object. To move an object to a new position decide where it has to go and use 
ors to help you decide which coordinate needs changing. The colored lines indicate a po
direction on the grid.

See Lock Size on page 4-19 for further details.
2-34
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From the Palettes menu, select the Cursor Options palette to open this palette again. Tu
snapping Hot Spots:

Turning on Snap Hot Spots specifies that an objects ‘Hot Spots’ should be activated as s
ping points. Hot Spots are points in addition to the corners and mid points of an object’s 
bounding box and are automatically added to wall objects at the top and bottom of the w
each corner. In this example we need to turn on Snap Hot Spots to enable us to line the
place up with the corners of the chimney breast.

Select the arrow tool and drag to move the fireplace until snapping lines show that it’s ba
corners have snapped to the corners of the chimney breast.

Reposition the sofas if necessary. Note: you may need to turn off snapping to do this.
2-35
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Add the Remaining Furniture

Use the methods described above, changing the view and turning snapping on and off a
sary, add the following furniture and accessories to the room. Note that most items have
entation assigned to them, so will be placed in the room the correct way up. Objects will
snap to the surface they are dropped on, so ensure the mouse is over the correct object
releasing the mouse button. Resize items as required.

• Add a rug to the floor between the two sofas. (Blue Rug in the Misc Furniture library

• Place a coffee table on the rug. (Rectangular Coffee Table in the Tables library.)

• Place a vase on the mantelpiece. (Vase in the Misc Furniture library.)

• Put a picture on the wall above the fireplace. (Picture in the Misc Furniture library.) 
Change the view to show the wall above the fireplace and drag and drop the picture
this surface. Change the view back to a top view.

• Add a radiator to the top wall of the room. (Detailed Wall Radiator in the Misc Furnitu
library.) After dragging and dropping the radiator onto the wall, use Gravity to drop it
the floor.

• Position a chest against the left wall of the room. (Chest in the Bedroom library.) Drag
and drop onto the wall and use Gravity to drop it to the floor.

• Put a plant on top of the chest. (Plant in the Plants library.)

Your room should now look something like this:
2-36
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Select Home View from the View popup menu at the bottom of the document window to 
at the scene from within the room:

Save the file.
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υ Lighting

Wall Lights

Use the NaviCam palette to change the view so that you are looking at the right wall and
see the alcoves at either side of the fireplace (you may need to click on the Zoom button
NaviCam palette and drag down to zoom out):

From the Lighting library, drag and drop an Extended Wall Lamp on to the wall of each a

Zoom Button
2-38
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Position the lights so that they are both the same height from the floor using either snapp
adjusting the height (Y position value) for each light in the info palette:

Sun Light

Select the Sun Direction tool in the Tools palette:

The Lights palette is displayed and the document view changes to a top view:
2-39
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A red line with a handle at the end of it shows the current sun direction. Click on the han
and drag to adjust the direction of the sun light:

Lights Palette

Experiment with the controls in the Lights palette to see how they affect the scene.

See Lights on page D-20 for further details.

Save the document.
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υ Colors and Textures

Colors and textures can easily be applied to objects within your room. In this example w
use those provided in the libraries included, but as any pict image can be applied as a te
you can scan actual paper and fabric samples to use in your interior design.

Add Colors

1. Open the Libraries palette if necessary by selecting its name in the Palettes menu

2. Choose Colors from the Display menu to open the Colors library.

3. Click on a suitable color and, holding down the mouse button, drag the cursor ove
of the sofas in the room. When the mouse is over the sofa, release the mouse bu
drop the color onto it.

4. In the same way drag and drop the same color onto the second sofa.

Add Textures

1. Open the Textures Small library.

2. Drag and drop a suitable cloth texture onto the rug on the floor of the room.

3. Drag and drop a suitable wallpaper texture onto the walls.
2-41
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4. Drag and drop the ‘Wood Boards’ texture onto the floor.

Adjusting Textures

As the texture applied to the floor is much too large, we will adjust it using the Textures pa
This opens automatically when a texture is dragged and dropped onto an object, but can
opened by selecting its name in the Palettes menu.

1. Select the floor. Its texture is displayed in the Textures palette:

2. Ensure that the Constrain Horizontal and Vertical Scale checkbox is checked on.

3. Click and drag on either the Horizontal Scale or Vertical Scale scrollbar to increas
texture scale to about 6, or enter 6 in the Horizontal Scale or Vertical Scale field.

Scale/Offset Selector Constrain Horizontal
& Vertical Scale
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Note: Hold down the Shift key ( ) while dragging on a scroll bar to adjust the scale 
whole numbers.

4. The texture on the floor is scaled accordingly:
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5. Click and drag an the Rotation scrollbar to rotate the texture on the floor so that th
‘floor boards’ appear to run up and down the room or type 74° in the Rotation valu
field and press Enter ( ):

6. The texture on the floor is rotated accordingly:

See Textures on page D-34 for further details.

Adding Textures to Objects

Sometimes you may wish to apply a color or texture to just part of an object rather than 
whole object. Depending on how the object is constructed, it is usually possible to add co
texture to individual surfaces.

1. Select the fireplace.
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2. Select Dismantleable from the Options menu. This allows an object to be broken 
into its component parts.

3. Select Edit Group from the Options menu. An editing window opens showing only
fireplace.

4. Select Right and then Look At Selected from the View popup menu. This positions
so that it looks towards the front of the fireplace and places the fireplace at the cen
the view.

5. Open the NaviCam palette and change the view so that you can see the whole fir

6. Select Dismantleable again, then choose Ungroup from the Edit menu. The firepl
broken down into its separate component parts:

Mantelpiece

Fire Surround

Hearth
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7. Choose Select None from the Edit menu to deselect all the objects.

8. Drag and drop the ‘White Marble’ texture onto the surfaces of the fire surround.

9. Drag and drop the ‘Blue Mosaic’ texture onto the surfaces of the hearth.

10. Adjust the textures on each surface as necessary. Note that you will probably nee
uncheck the Constrain Horizontal and Vertical Scale checkbox to adjust the Horiz
and Vertical scales independently:

11. Click on the top left corner of the editing window to close it. The fireplace remains i
original position within the room, but now displays the two new textures applied. 
Change the view using NaviCam to look at the fireplace:

See Dismantleable on page 3-35, Edit Group on page 3-32 and Ungroup on page 3-25 f
more details.

Save the document.
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υ Add a Ceiling

As we have now finished our interior design we can add a ceiling to the room.

1. Click on the walls to select them.

2. Choose Ceilings from the Plug-in menu:

3. An alert displays warning you that it is difficult to place objects in a room once the
ing is in place, and also that ceilings are drawn in such a way that they can only be
from below. If you view the room from above, the ceiling will be invisible, although 
ceiling object is still present. Click OK to close the dialog.
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4. A ceiling is added to the room:

Save the document.

υ Adjust Lighting

Open the Lights palette if necessary by selecting its name in the Palettes menu.

Adjust the brightness of Spot/Point lights, Ambient light and Sun light, or turn lights off an
to see the effect on your scene.

Set the lighting levels to give the effect you desire for your final render.
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To see the effect of lighting on the final render we have included the Microspot  Preview
derer within the Renderer Options palette.

1. Open the Renderer Options palette by selecting its name in the palette menu.

2. Uncheck the Show Grid option so that the document grid and axis lines are hidde

3. Select Microspot Preview Renderer from the Renderer pop-up menu.

4. The scene will now be rendered in preview quality.

5. Experiment with the light setting until you reach the desired lighting effect. 

See Lights on page D-20 for further details.

υ Look Around

Select the VR tool in the Tools palette:

When the VR plug-in is selected, the NaviCam palette is automatically opened so that yo
also use it to make changes to the camera position and view.

Select the From Door view from the View popup menu then click in the document windo
hold down the mouse button and drag to look around the room using the following contr

• To pan the camera (turn it left and right): drag the mouse left and right.

• To tilt the camera: drag the mouse up and down. The tilt is limited to +/- 90°.

• To crab the camera (move it to the left or right): hold down the Command key (/ ) 
and drag the mouse left and right.

• To move the camera forwards and backwards: hold down the Command key (/ ) and 
drag the mouse up and down.

• To zoom in: hold down the Shift key ( ).

• To zoom out: hold down the Control key.
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As you move, the cursor changes to an arrow head pointing in the direction you are mov
all cases, the further you move the mouse from the point first clicked on, the faster the c
will move.

Select From Door in the View popup menu to return to this view again.

Using either the VR tool, Orbit tool, Walkthrough tool or NaviCam palette to set the view
your final render.

Save the document.

υ Final Render

Now that our room is complete and we have chosen a specific view, we can produce a h
quality render.

1. Open the Renderer Options palette by selecting its name in the Palettes menu.

2. Uncheck the Show Grid option so that the document grid is hidden.

3. Hold down the Option key (alt/ ) and select Microspot Renderer from the Rendere
popup menu.
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4. A dialog displays any options available for the Microspot renderer. Click OK.

5. The scene will be rendered at a higher quality. Status information displays in the H
palette.

6. Experiment with the lighting controls in the Lights palette and the Renderer Option
see how they affect the quality and realism of the render produced.

Note: Always reselect the Interactive Renderer in the Renderer pop-up menu in the Rend
Options palette before making any changes to your scene or view.

See Appendix I — Microspot Plug-in Renderers on page I-1 for more details.
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υ Export Picture or Print

Now that the final render has been produced we can export a picture and/or print the wi
view.

Export Picture

The Picture plug-in provides several format options for saving your document view.

1. Select Picture from the Export submenu. The Save Picture Options dialog display

2. Choose the desired pixel depth from the Pixel popup menu.

3. Enter a value in dots per inch to specify the resolution at which the picture is to be
saved.

4. Select Dots, Millimeters or Inches from the units popup menus (constraining the p
portions of the image by checking the checkbox if necessary), then enter values f
width and height required.

5. Click on the Resize to Window button to change the resolution back to 72 dpi and
width and height to the width and height of the contents of the document window.

Click OK to accept the options as set. Enter a name and select a location to save the file
standard Save dialog that displays and click Save.
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Then a small dialog will show, displaying the current progress of the render to file. You m
cancel this at any time by clicking on the cancel button.

Note: When saving as TIFF output set the TIFF Options to Millions of Colors or less. 

Print

To print the document view, select the Print tool in the Tools palette:

The cursor changes to a printer. Move it over the document window and click. The stand
Print dialog displays. Enter the required number of copies etc. in the Print dialog and clic
to print the view.

υ Summary

This tutorial should have given you a good idea of the capabilities of Interiors and explai
how to use many of the features. Please refer to the reference part of the manual to exp
many more advanced features available.
2-53



3

Chapter 3

Menus

Details of the application’s File, Edit, View, Options, Palettes, Plug-in and
Help menus. Command key shortcuts can be used to perform many menu
commands. See Appendix L — Command Key Table on page L-1 for details.
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 INTERIORS MENU

Click on the word Interiors at the top left of the screen to display the Interiors menu. The
three items relate to Interiors:

υ About Interiors

Select About Interiors to display the About Interiors dialog. This provides information abo
the version of the application you are running, registration and serial number details.
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υ About Plug-ins

Select About Plug-ins and hold down the mouse button to display the list of the plug-ins
are currently running:
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Select a plug-in name from the list to display a dialog containing brief details about the p
in.

υ Preferences

Select Preferences to display the Preferences dialog:
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Color Preferences

To change color preferences, click on a color square to display the Color Picker. Select 
color and close the Color Picker.

• Handle Color: The color of the handles on the bounding frame of a selected object.

• Open Handle Color: The color of the handles on the bounding frame of a group of obje
when an Editing or Group window is open, and the color of the active handle when a
object is being resized.

• Locked Handle Color: The color of the handles on the bounding frame of a locked obje

• Light Marker Color: The color of the cone or point marking the position of a Spot/Point
Light. If this color is set to white, the color of each light marker will be the same as t
color of the light.

• Grid Color: The color of the grid.

• Background Color: The color displayed in the background of a new file.

• Default Color: This is the color that displays in the color block in the window toolbar an
used to draw new objects.

• World X, Y, Z Color: The colors that are used to draw the respective axis.

• Object X,Y,Z Color: The colors that are used to draw the lines of the bounding frame o
object.

Default Tool

Choose either the Arrow or Rotate Tool as the default tool.

Options

• High Resolution Printing: Click to print at printer resolution rather than screen resolutio

• Sound On: Click to play sounds within the application.

• Dynamic Updates: If this option is enabled, all open windows for a particular documen
will automatically be updated as objects are created or manipulated in the active win
and as slider bar controls in palettes are changed. If this option is not enabled, only
active window will be updated as actions are performed. Other open windows will no
updated until the action is complete and when moving slider controls, views will not 
updated until the mouse is released.
3-6



er 

 to 
active 

 an 

lps to 

able 

 docu-
eans 
ument 
n to 
ment. 

ory 

fect 
the 
y and 
• Solid Grid: Click to specify that the document grid should appear as a solid floor rath
than a wire frame grid.

• Global Lights: When this check box is enabled, the controls in the Lights palette relate
the document. When it is not enabled, the controls in the Lights palette relate to the 
window only.

• Advanced Handles: When this option is checked on, the lines of the bounding frame of
object can be clicked on and dragged to resize the object. The default setting is off.

• Auto Show Plug-in Palettes: When this option is checked on, whenever a plug-in tool is 
selected in the Tools palette, any plug-in palettes that are associated are opened.

• Auto Hide Plug-in Palettes: When this option is checked on, whenever a plug-in tool is 
selected in the Tools palette, any plug-in palettes currently open are closed. This he
prevent your work space from becoming too cluttered.

• Do Undos: The Do Undos checkbox is used to specify whether or not you wish to be 
to use the Undo command. It is checked on by default.

Note: To be able to perform an Undo command, the application must store a copy of the
ment (or parts of it) before carrying out any action that will change the document. This m
that you could need twice as much memory to be available for the application as the doc
itself requires. It also means that for large documents, the time it takes for the applicatio
store the copy of the file may result in unacceptably slow updates as you edit your docu
Un-checking the Do Undos checkbox will therefore allow the application to use less mem
and also speed up the updating of large documents.

• Display X, Y, Z World Axis: These options enable the display of the world axis that are 
drawn with the origin in the center of the grid.

• Edges to a Circle: Enter a value for the number of sides a circle should have. This will af
the appearance of circles, spheres, cylinders, etc. The lower the value, the coarser 
curve. The higher the value, the more memory and disk space you will need to displa
store the images. The default value is 24.
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υ Quit

• Quits the application and closes all open files and their associated windows. If any o
files have been changed without being saved, a dialog will display asking if you wish
save the changes.

FILE MENU

υ New

Creates a new, untitled document.
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υ Open

Opens an existing Interiors file, or any other file created by a 3DMF-compatible applicat
Such as Microspot Modeler or 3D World ).

Select Open and a standard dialog displays for you to select the file to open.

υ Insert

Select Insert to bring 3DMF or picture files into documents.

When the standard dialog displays, select a file to insert. The Insert Dialog will display:

The options available will depend upon the type of file selected, and whether an object w
selected when Insert was chosen. The type of file selected will be indicated on the right s
the dialog.

Add as Object

The selected file appears either in the center of the grid or at the last place the mouse w
clicked.
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• 3DMF file: Appears as a 3D object, the orientation of which will depend on the informa
contained in the 3DMF file.

• Picture file: The image displays as a rectangle with the same proportions as the origin
picture. The longest side of the rectangle is equivalent to the length of one side of on
square and its orientation relates to the grid.

Add to Object

This option is only available if an object was selected in the document before Insert was
sen. The file is converted to a picture (if necessary) and applied to the selected object a
ture. The properties of the selected object will determine how it is applied.

Available for:

• 3DMF file
3-10
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• Picture file

Fore/Background Picture

The file is converted to a picture (if necessary) and placed in the foreground/background
it remains even if the view changes. If the proportions of the image are not the same as t
portions of the window, the image is distorted to fit the window. Its size remains constan
tive to the window size.

Available for:

• 3DMF file

• Picture file

υ Import

The Import submenu allows you to access Import options.
3-11



tion 

 

nt to 
g 

 

Open the file menu and select Import. A submenu lists the Import options. Select the op
you wish to use from the list.

3DMF is the only Import option that is part of the application. All other Import options are
plug-ins. See Appendix A — Appendix A on page A-1 for more details.

3DMF

Select 3DMF and the following dialog displays:

As 3DMF is the native file format of the application, you can import 3DMF objects by

• Using the Insert command. See Insert on page 3-9 for further details.

• Opening a 3DMF document and dragging and dropping items from the new docume
the current document. See Open on page 3-9 for more details. and Appendix J — Dra
and Drop on page J-1 for details.

• Dragging and dropping a 3DMF file from the Finder into the document. See Appendix J —
Drag and Drop on page J-1 for details.

υ Export

The Export submenu allows you to access Export options.
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Open the file menu and select Export. A submenu lists the Export options. Select the op
you wish to use from the list.

3DMF is the only Export option that is part of the application. All other Export options are
plug-ins. See Appendix B — Export Plug-ins on page B-1 for more details.

3DMF

Select 3DMF and the following dialog displays:

As 3DMF is the native file format of the application, you can export 3DMF objects by

• Using the Save or Save As command. See Save on page 3-15 and Save As on page 3-1
further details.

• Dragging and dropping items from the document to the Finder or another application
supports 3DMF and Drag and Drop. See Appendix J — Drag and Drop on page J-1 for
details.

Picture

Select Picture and the following dialog will display:
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This dialog asks for you to enter some information about the picture that you wish to exp
including the size and color depth of the resulting image. The dialog will also display the
of the corresponding image, which you can use to help you get the image that you requ
Resize to window will resize the image so that it is the same size as the active window. W
you are happy, click ok. 

The next dialog asks you where to put the file, and when you are happy, click ok. Finally
small dialog will appear, keeping you informed of the progress of the render to file. Click
cel at any time to stop the render.

υ Close

Closes the current document and its associated windows. If the document has not been
or if changes have been made to it since it was last saved, an alert will display asking if 
want to save the document before closing.
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υ Save

The Save option is only available if a document has never been saved, or if changes hav
made to it since it was last saved. Using the Save option saves the document in 3D meta
mat. If the document has not been saved before, a dialog will display for you to specify t
document name and a location to save it.

υ Save As

Choose to save a document (in 3D metafile format) under a different name or in a differe
location. If you try to save a document in the same location as a document of the same 
an alert will ask if you wish to replace the existing file.

υ Revert

Returns to the last saved version of a document. (This option will only be available if the
ument has been previously saved.) An alert will display to ask if you are sure you wish to
revert.

υ Page Setup

Select to display the Page Setup dialog. The options available in the Page Setup dialog
depend on the printer driver you have selected in the Printer Setup Utility.
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υ Print

Select to display the Print dialog. The options available in the Print dialog will depend on
printer driver you have selected in the Printer Setup Utility.

EDIT MENU

υ Undo

Allows you to undo your last object manipulation. Selections, de-selections and view cha
are not object manipulations, and therefore cannot be undone.
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This option will be disabled if no document is open, if an open document has not been ch
since it was last saved, or if Do Undos has been turned off in the Preferences dialog. See 
Options on page 3-6 for further details.

After an object manipulation has been undone, the Undo option will change to Redo. Se
Redo to perform the action again.

υ Cut

Removes a selected item from the current document and places it on the clipboard whe
remains until replaced by another item cut or copied from the document.

υ Copy

Copies a selected item from the current document and places it on the clipboard where 
remains until replaced by another item cut or copied from the document.

υ Paste

Pastes items into the current file either in the center of the grid or at the last place the m
was clicked. 3DMF or PICT files can be pasted into Interiors documents. 3DMF data are
pasted in as 3D objects and PICT files are pasted in as rectangles.
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υ Paste Special

Paste Special is only available if you have cut or copied items from an application other 
Interiors. When you select Paste Special, the following dialog displays:

Items cut or copied from other applications can be placed in Interiors documents in a var
ways, depending on their formats. If you have cut or copied multiple data types, you can
the list on the right of the Paste Special dialog to select the data type you want to place i
document.

The Paste Special options available to you will depend on the type of file selected, and w
an object was selected prior to choosing Paste Special.

Add as Object

The file will appear either in the center of the grid or at the last place the mouse was clic
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• 3D Object: Appears as a 3DMF, the orientation of which depends on the information c
tained in the 3D object file.

• Picture: The image displays as a rectangle with the same proportions as the original 
ture. The longest side of the rectangle is equivalent to the length of one side of one 
square, and its orientation relates to the grid.

Add to Object

This option is only available if an object was selected in the document prior to choosing 
Special.

Available for:

• 3D object: The file is converted to a picture and applied to the selected object as a tex
The properties of the selected object will determine how it is applied.
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• Picture: The file is applied to the selected object as a texture. The properties of the se
object will determine how it is applied.

Fore/Background Picture

The file is converted to a picture (if necessary) and displayed in the document foregroun
background where it remains even if the view changes. If the proportions of the image a
the same as the proportions of the window, the image is distorted to fit the window. Its s
remains constant, relative to the window size.

Available for:

• 3D object

• Picture
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υ Delete

Use the Delete command to remove items or attributes without placing them on the clipb
The six options in the top part of the popup menu are only available if an item is selecte
within the document before Delete is chosen.

Select the appropriate option to delete the entire object, or a specific attribute of the obje
entire object can also be deleted from a file by dragging and dropping it into the trash ca
Although the object will be removed from the file, a clipping will remain in the trash can u
it is emptied. This allows you to drag and drop the item back into the document if neces

The last three options in the Delete menu allow you to remove the document’s backgrou
color, background picture and foreground picture.

υ Select All

Selects all of the objects in the current window.
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υ Select None

Deselects all of the selected items in the current window.

υ Duplicate and Clone

hen an object is duplicated, the duplicate is created as an entirely separate item and is u
to the original.

1. Select an item or group of items and choose Duplicate.

2. A duplicate of the selected item or group of items is placed one grid square to the
of the original:
3-22



pli-

upli-
3. Move the duplicate and choose Duplicateagain.

4. The second duplicate will be positioned in the same position relative to the first du
cate, as the first duplicate was to the original:

Any rotations that are applied after the first duplication are also applied to subsequent d
cated items. This is useful for drawing items like spiral staircases.

Hold down the Shift key when using the Duplicate option to avoid applying any offset.
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υ Group

Groups two or more objects and allows them to be manipulated as a single object.

1. Select the desired items, then choose Group. Grouped items will be surrounded b
bounding rectangle or sphere depending on whether the arrow or rotate tool was u
select them:

2. Double-click on the group or choose Edit Group from the Options menu to open a
window containing only the items within the group:
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3. Manipulate these items individually, then close the window to view your changes in
original document:

While a Group window is open, the handles of the bounding rectangle or sphere around
original grouped items will change color. This indicates that the objects are selected, an
Group window is open. The color of the handles is set in the Preferences dialog. See Color 
Preferences on page 3-6 for further details.

If the grouped objects have been placed in further groups, the Group window will contai
grouped objects. Double-clicking on these groups will open additional windows showing
contents of their respective groups.

If a group of objects is flagged as Primitive, it is not possible to edit the items within the g
by double-clicking on the group or choosing Edit Item from the Options menu. The grou
must be flagged as Dismantleable before the individual items can be edited. The Primitiv
Dismantleable options are available in the Options menu and the Info palette, and are d
cussed further in the sections Primitive on page 3-34, Dismantleable on page 3-35 and Prim
tive/Dismantleable on page 4-18.

υ Ungroup

Un-groups selected items so that members of a group can be selected individually. Note
this option only un-groups one level at a time.

If a group is flagged as Primitive, the Ungroup option will be grayed out in the Edit menu
will not be selectable. The group must be flagged as Dismantleable before it can be un-
grouped. The Primitive and Dismantleable options are available in the Options menu an
Info palette, and are discussed further in the sections Primitive on page 3-34, Dismantleable on
page 3-35 and Primitive/Dismantleable on page 4-18.
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VIEW MENU

υ New Window

Opens a new window for the current document. The new window displays the same view
the original window, and is offset from it. Use the Change View menu to change the view 
new window to display a different view of the same document. See Change View on page 3-2
for further details.

υ Close Window

Closes the current window. If this is the last open window for a document, the document
also be closed. If you have made changes to the document since it was last saved, an a
plays asking if you want to save the changes. If you save your changes then later reope
document, the same view as when the document was closed will be displayed. To save 
with a name, use the Name View option before closing the window. See Name View on page 3
27 for further details.
3-26



 name 
ant to 

nd 

ted.
υ Name View

Saves the current view. Enter a name for the view in the dialog that displays:

You cannot use the names of the standard views included in the program. If you specify a
that has already been used to save a nonstandard view, an alert displays asking if you w
replace that view.

υ Delete View

Deletes a saved view. This option is only available when new views have been created a
saved (standard program views cannot be deleted).

1. Select Delete View and a submenu lists the views that may be deleted:

2. Select the name of the view to delete from the submenu and the view will be dele
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3. If you do not select a view from the submenu, the delete view dialog displays sho
the views that can be deleted

4. Select the view to delete and click OK.

Note: If a document window was displaying a view that has now been deleted, the window
remain open as an untitled view.
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υ Change View

Click on Change View to display a popup menu which lists the available views (including
that you have saved). The view in the current window will be indicated by a check mark. M
the cursor down the list to select the desired view:

The current window will change to reflect your choice. If a standard view has been chan
hold down the Option key and select the name of the standard view to reset it to the def
standard view.

The view displayed can also be changed via the Command key shortcuts shown in the C
View popup menu above, or through the popup menu in the Window controls. See View on 
page 4-30 for further details..
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Look at Selected
Displays a selected object in the center of the window:

Home View
Returns the camera to its initial position (the view displayed when a new file is opened):

Custom

Any nonstandard view, or any view that has not been saved is a Custom view.
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Top, Front, Left, Right and Back
The five standard views that allow you to display the file from the sides and top:

Last View

The view that was displayed in the window immediately prior to the current view.

υ Open Documents

At the bottom of the view menu is a list of the documents and views that are currently op
The active window has a check mark to the left of its name. Documents that have been ch
since they were saved are underlined. Select a document/window name from the list to m
the active window:
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OPTIONS MENU

υ Edit Group

Select to edit individual objects within a group.
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Double-click on the group, or select the group and choose Edit Group from the Options m
to display a new window which contains only the items in the group.

The items can now be edited individually. As you edit the individual items, the group rem
locked in the original file window, although it will be updated to reflect any changes you m

Hold down the Option key when closing an editing window, and all editing windows for th
file will be closed.

Items and groups can be flagged as Primitive or Dismantleable. If the selected group ha
flagged as Primitive, Edit Group will be grayed out and will not be selectable. Flag the g
as Dismantleable to edit it. The Primitive and Dismantleable options are available in the 
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Options menu and the Info palette. See Primitive on page 3-34, Dismantleable on page 3-3 
and Primitive/Dismantleable on page 4-18 for further details.

υ Lock

Protects a selected object or group from being changed. A locked object can be groupe
other objects, but cannot be moved, resized or changed. If you group a locked object with
objects, the entire group will be locked.

If you place the cursor over a locked object, a padlock displays next to it.

An object or group can also be locked by selecting it and clicking on the large open pad
icon in the top right corner of the Info Palette. See Lock on page 4-18 for further details. 

υ Unlock

Select a locked object or group and choose Unlock to remove the protection against cha
An object or group can also be unlocked by selecting it and clicking on the large closed 
lock icon in the top right corner of the Info Palette. See Lock on page 4-18 for further details

υ Primitive

Specifies that an item or group should be treated as a basic geometry. A basic geometry
be un-grouped, so individual surfaces or items cannot be edited. An alternate method of
fying an object as a Primitive is to click on the Primitive/Dismantle button in the Info Pale
See Primitive/Dismantleable on page 4-18 for further details.
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υ Dismantleable

Specify that an item or group can be broken down into its component parts. This will allow
to ungroup an item or items and edit individual components as separate items. An altern
method of specifying an object as Dismantleable is to click on the Primitive/Dismantle bu
in the Info Palette. See Primitive/Dismantleable on page 4-18 for further details.

υ Grid Snap

Grid Snap applies an invisible grid to the document to which object points can snap. It is
enabled by default to make it easier to align objects. The distances between the nodes 
grid are determined by the value entered for the Snapping Grid Distance in the Grid Opt
dialog. See Grid Options on page 3-36 for further details.

When Grid Snap is enabled and a new item is drawn, the cursor is positioned on the clo
snapping grid intersection. As the object is drawn, the object’s handles snap to the snap
grid’s intersection points. As an object is resized, the object’s handles are positioned on 
ping grid intersection points. When an item is moved, its center point will snap to the sna
grid intersection points.

If Grid Snap was disabled when an object was randomly positioned in the file, the item w
moved or resized in increments of the snapping grid distance when Grid Snap is enable

Reselect the Grid Snap option in the Options menu to turn this option off.
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υ Grid Options

Choose Grid Options to display the Grid Options dialog:

• Solid grid: When this check box is enabled the documents grid will appear as a solid 
rather than a wire frame.

• Number of grid squares: This value relates to the visible grid. Enter a value to specify th
number of grid squares that should make up one side of the grid.

• Grid square size: This value relates to the visible grid. Enter a value to specify the lengt
one side of one grid square.

• Snapping grid distance: This value defines the invisible snapping grid. Enter a value for
length of one side of one snapping grid square. Typically, you will want to give the s
ping grid distance a value that is a fraction or multiple of one document grid square.

• Preferred unit size: This option allows you to select a unit size.

The entries in the popup menu are determined by whether metric or inches has bee
selected in the Options menu as discussed below.
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υ Metric

Select this option to use metric units of measurement. The grid size, position coordinate
dimensions will all be calculated using metric units. 

υ Inches 

Select this option to use inches, feet or yards as the units of measurement. The grid siz
tion coordinates and dimensions will all be calculated using inches, feet or yards.

υ Orbit Around View

Select Orbit Around View to rotate the camera around the point at the center of the curre
view. Click anywhere in the window to stop the rotation.
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PALETTES MENU

Click on Palettes in the application menu bar to display a list of available palettes.  Selec
palette name from the list to open it.

The Tools, Info and Help palettes are the standard palettes included in the application. A
other palettes are plug-in palettes that can be loaded when the application is launched o
it is running.

When a palette is currently open, a tick will appear next to it in the palette menu. If it has
docked with another tab, but is currently not visible, a diamond will appear next to it in th
menu.

See Chapter 4 — Tools Palette on page 4-4 for details of the Tools, Info and Help palette
Appendix D — Plug-in Palettes on page D-1 for details of plug-in palettes.
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PLUG-IN MENU

Click on Plug-ins in the application menu bar to display a list of available plug-ins. 

Select the plug-in name from the list to open it.

See Appendix C — Menu Command Plug-ins on page C-1 for details of plug-ins accesse
the plug-ins menu.

HELP MENU

υ Interiors Manual

Select this option to launch and display the manual.
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υ Microspot Library Download

Select Microspot Library Download to go to the Microspot Download web page to downl
the latest libraries and updates.

υ Registration Information

Select Registration Information to register your product via the Microspot web page. The
ister Information dialog displays:

Click on the Connect button in the dialog to go to the web page or alternatively, register 
product by filling in and returning the registration card included in the product box.
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υ Upgrade Information

Select Upgrade Information to obtain product upgrade information (if any) from the Micro
web page. The Upgrade Information dialog displays:

Click on the Connect button in the dialog to go to the web page or alternatively, contact 
Microspot via telephone, fax or email for upgrade information.
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Chapter 4

Palettes

The Tools, Info and Help palettes are the standard palettes included in the
application. All other palettes are plug-in palettes that are loaded when the
application is launched. 
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INTRODUCTION

To open a palette, select its name from the Palettes menu. The Palettes menu lists of al
available palettes.

The Tools palette displays automatically the first time the application is launched. The st
and position of all palettes is remembered each time the application is opened. Close a 
by clicking on the top left corner of the palette window.

Window controls are displayed at the bottom of each document window and these are a
cussed in this section of the manual.
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TOOLS PALETTE

The tools built-in to the application Tools palette are the Arrow, Rotate, Rectangular Mar
and Hand tools.

The rest of the tools are plug-ins that are loaded when the application is launched 

Select the tool to use by clicking on its icon in the Tools palette. After a tool has been use
currently selected tool reverts to being the Arrow tool, unless the default tool is changed 
Preferences dialog. See Preferences on page 3-5 for further details. You can, however, double-
click on any tool to lock it in so that it will not change after you use it, but will remain sele

υ Select/Move

Both the Arrow and Rotation tools can be used for selecting and moving objects. You ca
click and drag on the grid with either tool to move the entire scene in the window. See Manip-
ulating The Grid on page 4-10 for further details.

Note: Objects may be locked to prevent them being moved or rotated in one or more direc
or to prevent them being resized. See Lock Position on page 4-19, Lock Size on page 4-19,
Lock Rotation on page 4-20 and Lock on page 4-18 for more details.

Select

When an object is selected, it is surrounded by a bounding frame with handles at the po
where the bounding lines intersect:

Arrow (a)

Rectangular Marquee (m)

Rotate (r)

Hand (h)
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To temporarily hide an object’s bounding frame, hold down the Option key and click on t
arrow or rotate tool. The item is still selected, but the bounding frame and handles do no
play. To re-display, click on the arrow or rotate tool again.

To add objects to a selection, hold down the Shift key and click on the additional objects
deselect one object in a selection, hold down the Shift key and click on the object. If you
on an object that is part of a group, the entire group will be selected and the bounding fr
will surround all of the items in the group. 

Double-click on a group of objects to open a new window in which the grouped items ca
edited:

When you close this editing window, any changes you have made will be reflected in the
nal document window. You can also edit a group by selecting it and choosing Edit Item f
the Options menu. See Edit Group on page 3-32 for further details.
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Hold down the Command key and click the mouse to select an object that is behind ano
object. Initially, the foremost object will be selected. The second time you click the mouse
next object back will be selected, and so on:

Move

To move an object, click on it, hold down the mouse button, and drag. Release the mous
ton to place the object in its new location. Hold down the Control key and drag up or dow
move the object closer or further away. If you hold down the Shift key, lines will display s
ing the X, Y and Z axes, and movement will be constrained to these axes: 

Objects can also be moved by entering coordinate values in the Info Palette. See Name on page
4-17 for further details.
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υ Select/Move/Scale

Note: Objects may be locked to prevent them being moved or rotated in one or more direc
or to prevent them being resized. See Lock Position on page 4-19, Lock Size on page 4-19,
Lock Rotation on page 4-20 and Lock on page 4-18 for more details.

Select an object with the Arrow tool, it will display surrounded by a bounding frame with 
dles at the corners.

As an alternative to clicking and dragging, you can move an object using the arrow keys
selecting the object and pressing the desired arrow key to move it one pixel. If you hold 
the arrow key, the object will move one pixel at a time until it has moved six pixels. It will t
begin to move at an accelerated rate. To move objects closer or further away, hold down
Control key while using the up and down arrow keys.

To change the size of an object, move the cursor over one of the handles of the boundin
frame. When the cursor changes to a white arrow, click the mouse and drag. The shape
of the object will change to reflect your actions:

Note: If the Advanced Handles preference is checked on in the Preferences dialog, the li
the bounding frame of an object can also be clicked on and dragged to resize the objectSee 
Preferences on page 3-5 for further details.

Hold down the Shift key when resizing an object to constrain movement to the X, Y, or Z
or to maintain the objects proportions. Four constraining lines are displayed. The red lin
4-7
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resents the X-axis; the green line the Y-axis; and the blue line the Z-axis. The pink line re
sents the line along which the object will retain its current proportions: 

If, after resizing the object, you hold down the Option and Shift keys and resize the obje
second time, the pink line will move to a position which allows you to constrain the objec
the proportions it was originally drawn with:

Objects can also be resized via the controls in the Info Palette. See Size on page 4-19 for fur-
ther details.
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υ Select/Move/Rotate

Note: Objects may be locked to prevent them being moved or rotated in one or more direc
or to prevent them being resized. See Lock Position on page 4-19, Lock Size on page 4-19,
Lock Rotation on page 4-20 and Lock on page 4-18 for more details.

When an object is selected with the Rotate tool, it displays surrounded by a bounding sp
with six handles.

To rotate the object, move the cursor over one of the widgets of the bounding frame. Wh
cursor changes to a white arrow, click the mouse and drag. The object will rotate to reflec
actions:

Note: holding down the Shift key while rotating an object using the handles, constrains th
rotation to 90°.

To rotate the object, in one axis only, move the cursor over one of the lines of the bound
frame. When the cursor changes to a white arrow, pointing right, click the mouse and dra
object will rotate to reflect your actions in one axis only:
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Note: holding down the Shift key while rotating an object using the rotation rings, constra
the rotation to 45°.

You can also use the arrow keys to rotate objects. If you hold down the arrow key, the ob
will rotate in 1° increments for 6°, then accelerate to 10° steps. If you hold down the Shif
while using the arrow keys, you can rotate objects in 45° increments. To tilt an object, ho
down the Control key and use the left and right arrow keys.

The arrow keys can also be used to move and rotate the camera when nothing is selecte
document window. The camera will either move or rotate depending on which tool is curr
selected. Use the control key to move the camera in the Z dimension.

υ Manipulating The Grid

The Arrow and Rotate tools can be used to move and rotate the grid, as well as objects,
ily manipulate your view of a document.
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Moving The Grid

Select the Arrow tool and move the cursor over the grid. Hold down the mouse button, th
sor changes to an open hand. Move the cursor up, down, left or right. The grid will move
reflect your actions:

Hold down the Control key and move the mouse up and down to move the grid closer an
ther away:
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Hold down the Shift key when moving the grid to display, and constrain movement to, the
and Z axes:

Additionally, you can hold down the command key to rotate the grid, whilst the arrow too
selected.

Rotating The Grid

Select the Rotate tool and move the cursor over the grid. Hold down the mouse button, t
sor changes to an open hand. Move the mouse up, down, left or right. The grid moves to
your actions:
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Hold down the Shift key while rotating the grid to constrain it to its initial plane. It can the
only be rotated in that plane:

Holding the command key down before grabbing the grid will allow you to switch betwee
rotating or moving the grid.

υ Rectangular Marquee 

Select the Rectangular Marquee tool, hold down the mouse and drag out a rectangle to 
one or several objects. (Note that if any part of an object is inside the marquee, that obje
also be selected.)
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To add objects to a selection, hold down the Shift key and drag a rectangle around the d
objects. To deselect items, hold down the Shift key and drag a rectangle around selected
You can also add or remove items from a selection by clicking on them with a Selection 
while holding down the Shift key.

υ Hand

Use the Hand tool to change the view of the document by altering the position of the cam
When you select the Hand tool, a frame will appear around the contents of the window. A
dle will also appear at each corner of the frame:
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You can either position the view within the frame, or position the frame around the view. 
position the view, click outside the frame and drag the mouse. To position the frame, clic
inside the frame and drag the mouse:

If you are in an elevation or orthogonal view, move the mouse left and right to crab, or up
down to change the camera height.

If you are in a perspective or user defined view, move the mouse left and right to pan the
era, or up and down to tilt the camera. Hold down the Option key and move left and righ
crab, up and down to change the height.

To zoom in on an object (note that you are not actually moving the camera, but rather na
ing the focus), click on one of the frame handles and drag it in towards the center of the
dow:
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When you select another tool, the window changes to show the view you have chosen:
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INFO PALETTE

The Info palette displays information about, and provides controls for you to adjust, the c
acteristics of a selected object or light.

Select Info from the Palettes menu to display the Info Palette. When it is first opened, all 
Info palette will be visible. To reduce the palette click on the button on the right in the top
corner of the palette. To extend the window, click again.

Note: The controls in the Info Palette will vary depending on whether you have selected a
object or a spot/point light in the document window:

υ Name

The Name box provides a space to enter a name for an object or group of objects. Thi
will be displayed whenever the object or group is selected.

 Lock Position

Lock Size

Lock Rotation

Constrain

Lock Object
Primitive/

Lock Reflective Color

Dismantleable Flag

Proportions

Lock Surface Color
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υ Primitive/Dismantleable

This option is only available when an item or group is selected. A Primitive item cannot b
ungrouped into component items. Click on the button to toggle between Primitive and Dis
tleable. The solid square button represents the Primitive state and the split button the Di
tleable state. An object can also be specified to be Primitive or Dismantleable by selectin
Primitive or Dismantleable from the Options menu. See Primitive on page 3-34 and Disman-
tleable on page 3-35 for further details.

υ Lock

To lock a selected object or group of objects, click on the padlock icon in the top right c
of the Info palette, or select Lock from the Options menu. See Lock on page 3-34 for furthe
details. This will prevent the object or group from being moved or changed. To unloc
object, click on the Padlock icon a second time, or select Unlock from the Options menSee
Unlock on page 3-34 for further details.

υ Position

The figures displayed in the X,Y and Z Position boxes are the grid coordinates of the cen
the selected object’s bounding rectangle. If you select items that are grouped together, t
coordinates displayed will relate to the group. If you select more than one item and the i
are not grouped, no coordinates will display. 

To precisely position an object, type in values for the X, Y and Z coordinates, then press 
The object will move to reflect your entries.
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Lock Position

The padlocks next to the position boxes are used to lock the position of an object. The lo
options work the same for groups of objects as for single objects.

Click on the padlock next to the X position coordinate. It will close, which means the obje
in a fixed position on the X axis (in relation to the grid), but can still be moved in the Y an
axes. Any or all coordinates can be constrained. If an object’s position is constrained on
three axes, it cannot be moved. However, you can still change the object’s size (unless i
also been constrained).

υ Size

The size boxes display the X,Y and Z dimensions of an object’s bounding rectangle. If y
select items that are grouped together, the dimensions displayed will relate to the group
bounding rectangle. If you select more than one item and the items are not grouped, no 
sions will display. To precisely resize an object, type in values for the X, Y and Z dimens
then press Enter. The object will be resized to reflect your entries.

Note: Information about the object’s size will be grayed out if you have selected a light as
objects have a constant size which cannot be changed.

Lock Size

The padlocks next to the size boxes are used to lock the size of an object. The lock opti
work the same for groups of objects as for single objects.

Click on the padlocks by the size dimensions to constrain an object’s size. Click on a clo
padlock to open it and un-constrain an object’s size. Any or all size dimensions can be c
strained. If all are constrained, the size cannot be changed. If just one dimension is con-
strained, you can change the other dimensions.
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Constrain Proportions

The Proportional Constrain checkbox to the bottom right of the dimension fields allows y
constrain the proportions of an object. Select an item and click on the checkbox to turn o
portional Constrain.

The item can now be resized or moved, but will always maintain its current proportions.

υ Rotation

Lock Rotation

Below the size controls are additional padlocks for the X, Y, and Z axes that are used to 
strain the rotation of an object.

Click on the padlock relating to the X axis. It will close, indicating that the object cannot 
rotated around the X axis (in relation to the grid), although it can still be rotated in the Y a
axes. The rotation of the object can be constrained in any or all of the axes. The X Y and 
are determined by the orientation of the object.

υ Transparency/Brightness

Transparency

Select an object and use the Transparency slider control to adjust its transparency.
4-20



• When the transparency slider is to the left of the bar, the selected object is opaque:

As the slider is moved along the bar, the object becomes more transparent:
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If a light is selected, the first slider control relates to the brightness of the light it emits:

υ Color

Surface

The Surface color box shows the color of the selected object.

To change the color of the object, click on the Surface color box to display the Color Pic
Select a color and close the dialog. The color you have chosen will be displayed as the S
color and applied to the selected object. 
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If a light is selected the Spot Light color box or Point Light color box is the color of the lig
emitted by the light object. The light marker color will also change to this color. If the ligh
marker color was changed by use of the Preferences dialog the light marker will stay the
erence color value. See Color Preferences on page 3-6 for further details. Colors can also be 
dragged and dropped onto the spot or point light color box.

Gloss

The Gloss color box shows the reflective color of the selected object. If light is shining o
object (sun light or spot/point lights), the part of the object that shines displays the gloss 
This will only be visible if you have selected the Best Shading option for the interactive r
derer, or the Microspot Renderer via the Renderer Options palette. See Renderer Options on 
page D-27 for more details. This option is not available for lights.

To change the reflective color of the object, click on the Gloss color box to display the C
Picker. Select a color and close the dialog. The color you have chosen will be displayed
Gloss color box. Colors can also be dragged and dropped onto the Gloss color box.

Lock Color

The padlock next to the color boxes is used to protect the color values of an object.
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If an object is selected, the second slider control relates to its amount of gloss or shinine
object has. Use the slider control to adjust the degree of gloss or shine you place on an 
The Matt- Gloss value is affected by the amount of directional light on an object:
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Spread

If a spot light is selected, the second slider control allows you to adjust the lens angle of
light and narrow or widen the beam. Note that this option is not available for point lights:
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Renderer Brightness

If an object is selected, the Renderer Brightness slider control allows you to adjust its refl
ity, which is the amount of ambient light the object reflects. This will only be visible if you
have selected the Microspot Renderer via the Renderer Options palette. See Renderer Options
on page D-27 for more details.:
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Sharpness

If a spot light is selected, the third slider control allows you to adjust the sharpness of the
Move the slider control to sharpen or un-sharpen the focus of the light. Note that this opt
not available for point lights:

υ Comments

The Comments box provides a space to enter details about an object or group of object
as a description). These comments will be displayed whenever the object or group is se
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THE HELP PALETTE

The Help palette displays coordinate values that show the position of the cursor and hel
sages or information relevant to the tool selected, cursor position or rendering status (if 
interactive renderer is being used).

Select Help from the Palettes menu to display the Help palette:

To resize the Help palette, click on the resize box in the bottom right corner of the palette
holding down the mouse button, drag to resize the palette. Release the mouse button w
palette reaches the desired size.
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WINDOW CONTROLS

The Window controls are displayed at the bottom of each window:

Selecting an option affects only that window, regardless of how many other views are op

υ Zoom Out

Use the Zoom Out button to widen the focus of the camera’s view and make objects app
be farther away. Position the cursor over the Zoom Out icon and click once to zoom out 
slightly. Click and hold the mouse button down to continue zooming out. 

υ Zoom In

Use the Zoom In button to narrow the focus of the camera’s view and make objects app
be closer. Position the cursor over the icon and click once to zoom in slightly. Click and 
the mouse button down to continue zooming in.
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υ View

Use the View popup menu to select a different view, including any view that you have sa
When you select a view option, the window will change to display your selection:

The Command key options and View menu can also be used to choose a view. See Change 
View on page 3-29 for further details.

υ Default Color

The color displayed in the color block at the bottom right of the window toolbar is the cur
rently selected color. Any new items created (except lights and markers) will automatica
this color, even if you are working in wire frame mode.
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To change the default color, click on the color block and select a new color from the Col
Picker:

To change an object’s color, click on the color block and drag the color over the object. I
be highlighted by a bounding frame to show that it is selected. Release the mouse butto
apply the color to the object. You can also select an object, then go to the Color Picker a
select a new color to automatically apply that color.

υ Window Resize

To change the size of the window you are working in, click on the Resize Window icon. H
down the mouse and drag to resize the window.
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Import Plug-ins

Import plug-ins are accessed via the Import submenu in the File menu.
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υ Introduction

Open the File menu and select Import. A submenu lists the installed Import options:

The 3DMF Import option is not a plug-in but part of the core application. See 3DMF on page 
3-12 for more details.

Select the option to use from the list.
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Appendix B

Export Plug-ins

Export plug-ins are accessed via the Export option in the File menu.
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υ Introduction

Open the file menu and select Export. A submenu lists the installed Export options:

The 3DMF Export option is not a plug-in but part of the core application. See 3DMF on page 
3-13 for more details.

υ Picture

The Picture plug-in provides several format options for saving your document view.

1. Select Picture from the Export submenu. The Save Picture Options dialog display

2. Choose the desired pixel depth from the Pixel popup menu.

3. Enter a value in dots per inch to specify the resolution at which the picture is to be
saved.
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4. Select Dots, Millimeters or Inches from the units popup menus (constraining the p
portions of the image by checking the checkbox if necessary), then enter values f
width and height required.

5. Click on the Resize to Window button to change the resolution back to 72 dpi and
width and height to the width and height of the contents of the document window.

Click OK to accept the options as set. Enter a name and select a location to save the file
standard Save dialog that displays and click Save.

Then a small dialog will show, displaying the current progress of the render to file. You m
cancel this at any time by clicking on the cancel button.

See Picture on page 3-13 for more details.
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Appendix C

Menu Command Plug-ins

Menu command plug-ins are accessed via the Plug-in menu.
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υ Introduction

Select Plug-ins from the menu bar. A list of available menu command plug-ins 

displays. Select the plug-in name from the list to use it. Hold down the Option key and s
the plug-in name to display any plug-in options that are available.

The first time the plug-in menu is selected, the top item in the menu, which is Last Plug-in
be grayed out. After selecting a plug-in, the top item will be the name of the last plug-in 
selected. This can be chosen by selecting the top item or typing Command - *.

υ  Auto Save

Select Auto Save to turn on the Auto Save feature. A dialog displays for you to enter a va
the Auto Save period.

Enter a value in minutes and click OK. A check mark will display next to the plug-in nam
show that Auto Save is on.
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After the specified period, a dialog displays warning that it is time to save and giving you
opportunity to turn Auto Save off, to close the dialog without saving, to automatically sav
future, or to save the document. To make this dialog disappear, but still save, just click o
matically save in future.

To turn Auto Save off, select the plug-in name again from the plug-in menu.

υ Base Plate

The Base Plate plug-in allows the user to add a plate onto the grid. The purpose of this p
to allow the model to cast shadows whilst being rendered, thus giving more depth and re
to the model created. To enable the base plate, simply click on it in the plug-in menu. The
will observe that a plate has been added to the grid, at roughly 90% of its size.

The plate itself is locked, and so cannot be moved, although you can unlock it to move i
around and change its color as you see fit.
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υ Ceilings

The Ceilings plug-in is used to quickly add ceilings to selected objects drawn with the 4 
or Walls drawing tools.

1. Draw an object using the 4 Walls or Walls drawing tool:

2. Select the object and choose Ceilings from the Command plug-in menu.
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3. An alert displays warning you that it will be difficult to position objects in a room on
the ceiling has been added, and that because of the way ceilings are designed, th
ing will not be seen unless viewed from below.

4. Click OK and a ceiling will automatically be added to the object.

υ Construct Idler

The Construct Idler plug-in is available as both a menu command plug-in and as an idle
in. See Construct Idler on page E-2 for details.
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υ Floors

The Floors plug-in is used to quickly add floors to selected objects drawn with the 4 Wal
Walls drawing tools.

1. Draw an object using the 4 Walls or Walls drawing tool:

2. Select the object and choose Floors from the Command plug-in menu.
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3. A floor will automatically be added to the object.

Note: Floors are designed in such a way that they can only be seen if viewed from above

υ Gravity

The Gravity plug-in is available as both a menu command plug-in and as a plug-in modi
See Gravity on page H-3 for details.
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Appendix D

Plug-in Palettes

Plug-in palettes are accessed via the Palettes menu. Select the palette name
from the list to open it.
Table of Contents

Introduction D-3
Tabbed palettes D-3

Align D-7

Axis D-7

Color D-10

Color Palette D-10

Cursor Options D-11
Snapping Options D-12
3D Cursor D-13

Libraries D-13
Selecting Library Items D-14
Storing Data D-14
Naming Items D-14
Retrieving Data D-14
Find D-15

Window Controls D-15
Zoom In/Out D-15
Horizontal/Vertical Arrows D-16
Delete Button D-16

Menus D-17
File Menu D-17
View Menu D-18
Display Menu D-20

Lights D-20
Spot/Point Brightness D-21
Ambient Brightness D-21
Sun Brightness D-21
Show Lights Markers D-22

NaviCam D-23
Height D-23
Position D-24
Zoom D-24
Clipping Planes D-24
Hither Clipping D-25
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Yon Clipping D-25
Position Buttons D-25

Nudge D-25
Move D-26
Rotate D-27

Renderer Options D-27
Camera D-28
Renderer D-28

Renderer Options D-29
Style D-29
Shading D-30
Backface D-32
Show Grid D-33
Show Markers D-34

Textures D-34
Texture Palette Options D-35

Tripod D-38
Look At Selected D-38
Zoom D-39
Height D-39
Pan/Tilt D-39
Step/Crab D-39
Home View D-39
Take Picture D-39
Clipping Planes D-39
Hither Clipping D-40
Yon Clipping D-40

Windows and Doors D-40
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υ Introduction

Click on Palettes in the application menu bar to display a list of available palettes. Selec
palette name from the list to open it.

The Tools, Info and Help palettes are not plug-in palettes but are part of the core applica
See Chapter 4 — Palettes on page 4-1 for details.

Tabbed palettes

When a palette is opened it displays in a window with the palette name on a tab at the t
the palette.
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Tabbed palettes can be stacked together by simply clicking on the palette tab and dragg
palette onto the tab area of another tab palette:

Both palettes then appear in the same palette. To access a palette click on its tab.

Any number of tabbed palettes can be stacked together, although in practice you may w
limit this to the number of tabs that are visible in a palette.
D-4



to the 
To remove a tabbed palette from a stack, click on the palette tab and drag the palette on
desktop.

The palette will appear on its own, while the other palettes remain stacked together.
D-5



vides 
ck.
Click on a palette tab and hold down the mouse button to display the tab menu. This pro
an alternate method of selecting other palettes or of disconnecting a palette from the sta
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υ Align

The Align palette is used to align objects in any or all of the X, Y and Z axes.

1. Select Alignment from the Palettes menu to display the Alignment palette:

2. Select two or more objects in the document window then click on the buttons in th
Align palette to specify how the objects should be aligned in the X, Y and Z axes.

3. The graphic in the dialog, of three objects and their shadows, provides feedback 
how the alignment will take place.

4. Click OK to apply the Alignment options.

If one or more of the selected items are locked, they will not be moved, but other selected
will be aligned with the locked items. Locked items are treated as a single object for align
purposes.

The line of alignment relates to the object that is in the most extreme position in the rele
direction. For example, when choosing align right in the X-axis, the line of alignment is 
defined as the right edge of the bounding frame of the object furthest to the right.

υ Axis

The Axis palette is used to display the current orientation of the front window’s camera.
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Select Axis from the Palettes menu to display the Axis palette:

Select the Rotate tool in the Tool palette, click on the document grid and, holding down 
mouse button, drag to rotate the grid. Notice that the positions of the axes in the Axis pa
are updated to reflect the new orientation of the grid.
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Click on the palette’s zoom button to extend the Axis palette:

The axes are listed and the color of each axis shown. Next to the axis name is a checkb
is used to display or hide the axis. Checking the check boxes on or off to specify which 
should be displayed in the palette.
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υ Color

The Color plug-in displays a color picker, so that an object’s color or the default color ca
changed easily.

1. Select Color from the Palette menu to display the Color palette:

2. To change the color of an object, several objects, or a group, make a selection in 
document window. If nothing is selected, the default color will be changed.

3. Choose a color from the Color palette by clicking on the color wheel and/or adjus
the brightness slider bar and values for Red, Green, Blue, Hue, Saturation and Va

4. Click on the current color button to display the system color picker(s) if necessary
Note: Colors can be dragged to and from the current color button.

υ Color Palette

The Color Palette plug-in provides a repository for 12 colors.

1. Select Color Palette from the Palette menu to display the Color Palette:

2. To use a color in the Color Palette, drag and drop it onto an object, the background
or color box in the Info Palette, or select an object in the document window and clic
a color in the Color Palette.
D-10
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3. To change a color in the Color Palette, drag and drop a new color over an existing
or, when nothing is selected in the document, click on a color to open the color pi
and choose a new color.

υ Cursor Options

The Cursor Options palette allows you to control the alignment and positioning of objects
other objects, and the display and positioning of the cursor. Select Cursor Options from 
Palettes menu to display the palette. Click on the shrink/expand button at the top right o
palette to show or hide the lower section.
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Snapping Options

Snapping is the alignment of points with other points. When positioning objects, snap lin
will display (and sounds may play — See Play Snap Sounds on page 12) when the snap points
of the selected objects are aligned to the snap points of unselected objects.

• Enable Snap: Click on this check box to turn the Snapping features on or off. Alternativ
hold down the Control key and press the space bar to switch Snapping on or off.

• Snap to Bounding Box: Click on this check box to activate the eight corners of each obje
bounding box as Snapping points.

• Snap to Mid Points: Click on this check box to activate the mid points of each object’s 
bounding box as Snapping points, i.e. The points half way between the eight corner 
of the bounding box.

• Snap to Hot Spots: Click on this checkbox to specify that an objects Hot Spots should 
activated as Snapping points. Hot Spots are points in addition to the corners and m
points of an object’s bounding box. 

• Multiple Snap Lines: If this option is checked on, snap lines will display for all current 
alignments. If checked off, snap lines will display only for the first alignment found in
each axis.

• Play Snap Sounds: Check this option on to play sounds according to the snapping statu
objects being positioned. Three different sounds play in the following circumstances

If a point is aligned with, but not snapped to, another point.

If a point is snapped to another point.

If a point in no longer aligned with or snapped to another point.
D-12
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• Snap Line Color: Click on this box to display the Color Picker and select the color used
display the snapping lines.

3D Cursor

• Show Cross Hairs: Check this option to display cross hairs showing the position of the 
sor in the document in 3D space.

• Floating Cursor:  The cursor defines a position and an orientation for entering new obj
and usually snaps to the surface of any object below the cursor arrow. Check this op
specify that the cursor should not snap to the surface of any object below it, and shou
orientate itself in relation to that surface.

υ Libraries

The Libraries palette displays libraries of furniture items, doors, windows, textures, color
that can be used in your 3D scene.

Select Libraries from the Palette menu. The first time the Libraries palette opens, it open
the default libraries of the program. Every time after this the Library palette retains the li
the libraries selected:
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Selecting Library Items

When you click on an item that is stored in a library it will be outlined with a black rectang
show it is selected:

Storing Data

3DMF, PICT, and data in various other image formats can be stored in libraries. Interiors
includes several libraries of furniture and accessory items, doors and windows, colors a
tures, but you can also use the Libraries palette to store your own items. To do this drag
drop objects/groups of objects from Interiors into a library. You can also visit the Microsp
website to download more libraries, See Microspot Library Download on page 3-40.

Naming Items

Items are displayed in a library in the order in which they were entered.

If an item has a name attached to it, this name is displayed in the Name field at the bott
the palette when the item is selected. Unnamed items will display as untitled.

To name or rename an item, select its icon and enter a name in the Name field. Press th
or Return key, select another object or click on an empty space in the library and the ite
be updated with its new name.

Retrieving Data

To retrieve data from a library, drag and drop an item directly into your Interiors docume
D-14
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Find

Library items can be searched for by name. Enter text into the Find field at the top right 
Libraries palette. The first item found that matches the entered text will be selected:

Note: The Libraries palette searches for names that match or start with the name you en

Window Controls

Zoom In/Out

The Zoom controls at the bottom left of the palette can be used to increase/decrease the
the palettes contents:
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Horizontal/Vertical Arrows

• Horizontal Arrow: In the By Icon view, click on this button to display the Libraries pale
with a horizontal scroll bar. In the By List view, click on this button to display the prev
to the left of the item list:

• Vertical Arrow: In the By Icon view, click on this button to display the Libraries palette 
with a vertical scroll bar. In the By List view, click on this button to display the previe
above the item list:

Delete Button

• Delete: The Delete button removes the current selected library item:
D-16
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File Menu

New

Select New to open a new library. The standard dialog will display, allowing you to enter
name for the new library and specify a location to save it. A new, empty library will displa
the Libraries palette:

Open

Select Open to open an existing library. A standard Open dialog will display for you to se
the library to open. The selected library will display in the Libraries palette.

Open Defaults

On selecting Open Defaults all the programs existing default libraries will be displayed in
Libraries palette. 
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Close

Choose to close the current library. The Libararies palette save the library file whenever
add data, so you do not need to save any changes. The Libraries palette will remain ope
will display the contents of any other open libraries.

Close All

Choose to close all open libraries. The Libraries palette will remain open but will be emp

View Menu

By Icon

Select By Icon from the View menu to display picture previews of a library’s contents. 
Although the items’ names will not be displayed, you may still search for items by name 
the Find field at the top right of the Libraries palette.

By List

Select By List from the View menu to list a library’s contents by name. When By List is 
selected you can also choose whether to see a preview of an item when it is selected in

• Preview above: The preview is displayed above the list:
D-18



• Preview to left: The preview is displayed to the left of the list:

• No preview: No preview of selected items is displayed:
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Display Menu

The display menu lists all the libraries currently open. Select a library’s name from the li
display it or choose Show All to display the contents of all the open libraries in the order
which they were opened.

υ Lights

The Lights Palette is used to control the various lighting features available in the applica
Select Lights from the Palettes menu to display the palette:

Note: The Preferences dialog, accessed from the Edit Menu, contains a check box for G
Lights. If the Global Lights control is turned on, any changes made via the Lights palette
affect the whole document. If the Global Lights control is turned off, making changes in t
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Lights palette will affect only the current window. See Preferences on page 3-5 for further 
details.

Spot/Point Brightness

Lights are placed in documents by dragging and dropping light objects or furniture items
including lights into the document. When a light is placed in a document, its color, bright
spread and sharpness can be adjusted via controls in the Info Palette. See Info Palette on page
4-17 for further details.

• To manipulate all point or spot lights at once, use the Spot/Point Brightness slider co
in the Lights Palette.

• Use the checkbox to the right of the slider bar to turn all the point or spot lights on o

Ambient Brightness

Ambient light is the equivalent of daylight. It is a diffused light that has no specific point o
origin and casts no shadows.

• Use the Ambient Brightness slider bar to adjust the brightness of the ambient light.

• Click on the color box to display the Color Picker and select a color for the ambient l
or drag a color onto the color box.

• Use the checkbox to the right of the color box to turn ambient light on or off.

Sun Brightness

By default, sunlight shines from the South East at an angle of 45°. The direction of the su
can be adjusted using the Sun Direction plug-in. See Sun Direction on page H-5 for further 
details. Sunlight will affect your view of an object, and some surfaces will reflect more lig
than others.

• Use the Sun Brightness slider bar to adjust the brightness of the sunlight

• Click on the color box to display the Color Picker and select a color for the sunlight, 
drag a color onto the color box.

• Use the checkbox to the right of the color box to turn sunlight on or off.
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Show Lights Markers

Use this checkbox to specify whether Point and Spot Light Markers should be hidden or
played. The effects of the lights will be apparent regardless. Non-interactive renderers (s
the Microspot Renderer) will not display light objects whether they are hidden or not. See 
Appendix I — Microspot Plug-in Renderers on page I-1 for more details.
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υ NaviCam

The NaviCam palette provides a way of controlling the camera position and view.

Select NaviCam from the Palette menu to display the NaviCam palette.

The red square displayed in the palette, both in the height area and in the position plan,
sents the camera. The line from this square shows the camera view direction and at the
this line is the look at point or point of interest.

Height

Use the controls in the Height Area to adjust the position of the camera, or point of intere
the Y dimension. 

The long green line in the Height Area represents the grid height. The lines above it repr
height as determined by the size of the grid and each grid square.

• Click on the camera square and move it up or down to change the camera height w
maintaining the point of interest.

• Click on the view direction line (or anywhere in the Height Area except the camera 
square) and drag up or down to change the height of the point of interest without cha
the camera height. This is the same as tilting the camera.

Height Area
Position Plan

Zoom

Position Buttons

Grid Height

Clipping Planes
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• Hold down the Option key, click anywhere in the Height Area and drag up or down to
adjust the height of the camera and move the point of interest relative to the camera
height.

If the camera is moved out of the height range shown, the display will be rescaled so tha
camera square can still be seen. When the camera is moved back into range, the display
rescaled again.

Position

Use the controls in the Position Plan to adjust the position of the camera or the point of in
in the X and Z dimensions.

The Position Plan displays an image of the 3D scene in plan view.

• Click on the camera square and drag to change the position of the camera while ma
ing the point of interest.

• Click on the view direction line (or anywhere in the Position Plan except the camera
square) and drag to change the position of the point of interest without moving the ca
position. This is the same as turning the camera.

• Hold down the Option key, click anywhere in the Position Plan and drag to move the
era and move the point of interest relative to the camera position. This is the same a
step and crab movements of the camera.

If the camera is moved out of the plan shown, the display will be rescaled so that the ca
square can still be seen. When the camera is moved back into range, the display will be
caled again.

Zoom

Click on the Zoom button and drag up or down to zoom in or out on the scene.

Clipping Planes

The Clipping Plane controls are used to adjust the camera’s front (Hither) and back (Yon
ping planes.

Although the clipping planes themselves are invisible, the effect they have on objects in 
document can be seen. The front (Hither) and back (Yon) clipping planes can be set so th
view only a section of the document. Any objects or parts of the objects closer to the cam
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than the front (Hither) clipping plane, or further from the camera than the back (Yon) clip
plane, will not be visible.

Hither Clipping

Click on the Hither Clipping button and drag up to move the front (Hither) clipping plane 
ther away from the camera or down to move the front (Hither) clipping plane towards the
era.

Yon Clipping

Click on the Yon Clipping button and drag up to move the back (Yon) clipping plane fu
away from the camera or down to move the back (Yon) clipping plane towards the came

Position Buttons

Use the position buttons to move either the camera or the point of interest to predefined
tions.

• Click on the position buttons to move the camera while maintaining the point of inter
0° moves the camera to directly behind the point of interest, 90° to the right, 180° dir
in front of, 270° to the left, and so on.

• Hold down the Option key and click on the position buttons to move the point of inte
while maintaining the camera position. 0° moves the point of interest to directly beh
the camera, 90° to the right, 180° directly in front of, 270° to the left, and so on.

• Click on the ‘Mid’ button to move both the camera and the point of interest to predet
mined locations. The point of interest is positioned at the centre of the grid. The cam
placed half way between the centre and the side of the grid, directly in front of the po
interest. The camera will be at approximately eye height and tilted down slightly.

υ Nudge

Use the Nudge palette to move or rotate an object by a specified amount.
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Select Nudge from the Palettes menu to display the Nudge palette:

Move

1. Select an object in the document window.

2. Enter a value in the Move box in the Nudge palette. The units used will depend on
set for the document in the Options menu. See Options Menu on page 3-32 for furthe
details.

3. Click on the control buttons to choose the direction in which to move the selected
object. The direction relates to the current view.

Move Up

Move Down

Move Left Move Right

Move Closer Move Further Away
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Rotate

1. Select an object in the document window.

2. Enter a value in degrees in the Rotate box in the Nudge palette.

3. Click on the control buttons to choose the direction in which to rotate the selected
object. The direction relates to the current view.

υ Renderer Options

The Renderer Options plug-in palette is used to control the way that the document is disp
Choose Renderer Options from the Palettes menu to open the palette:

Rotate Up

Rotate Down

Rotate Left Rotate Right

Rotate Anticlockwise Rotate Clockwise
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Camera

Select Perspective or Orthographic from the Camera pop-up menu.

• Perspective: Objects are displayed in perspective mode to give the illusion of depth. P
lel lines are drawn so that if extended, they would converge at a given point:

• Orthographic: Objects are displayed in Orthographic mode. Parallel lines remain para
regardless of the distance they are supposed to be from the camera:

Renderer

Click on the Renderer popup menu to display any available renderers. 
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• Wire Frame: The surfaces of objects are not filled; only the edges of the surfaces are 
played:

• Interactive: Objects in the document are rendered using the programs interactive ren

• Microspot Preview Renderer: The scene is rendered using the Microspot non-interactive
renderer to produce a fast preview render of the scene with lighting and shadows. See 
Appendix I — Microspot Plug-in Renderers on page I-1 for more details.

• Microspot Renderer: The scene is rendered using the Microspot non-interactive render
produce a high quality final render. See Appendix I — Microspot Plug-in Renderers on 
page I-1 for more details.

Renderer Options

To the right of the Renderer popup menu is a button for Renderer Options. This is only ac
a non-interactive renderer is installed and selected. Click on the button to display any ava
options for the currently selected non-interactive renderer.

Note: Holding the Option key down while selecting the renderer will also display any opti
available.

Style

The Style pop-up menu is not available when the Wire Frame renderer is selected. Sele
of the following options from the menu:

• Filled: All surfaces are filled and rendered. Objects appear to be solid.
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• Edges: Only the edges of objects are rendered. This is different from Wire Frame mo
that lines are rendered according to the orientation of the object and any light sourc
rather than the lines being displayed as one solid color:

• Points: Only the vertex points of objects are rendered. Points are rendered according
orientation of the object and any light sources:

Shading

Select Plain, Smooth or Best from the Shading pop-up menu.
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• Plain: Surfaces are filled but not smoothed and steps of color can be seen within som
objects. Shading is applied according to the angle of the surface and any light sourc
will affect the object:

• Smooth: Surfaces are filled and smoothed. Shading is applied according to the angle 
surface and any light sources that will affect the object:
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• Best: Surfaces are filled and smoothed. Shading is applied according to the angle of 
surface and any light sources that will affect the object. This option also displays the
reflections of any lights:

Backface

The backface of an object is the side that faces away from the camera.

Select Show, Remove or Flip from the pop-up menu.

• Show: Select this option to show the backface of an object. This will not make any vis
difference if the object surfaces are filled, but if you are viewing the objects in wire fr
mode, you will be able to see the wire frame on the backface of the object:
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• Remove: Select this option to hide the backface of an object. This will not make any d
ence if the object surfaces are filled, but if you are viewing an object in wire frame m
its backface will not be displayed:

• Flip: The Flip option flips the backface so that the outside surface is now on the insid
This does not affect the shape of the object, but may alter the way it is rendered:

Show Grid

Documents are automatically displayed with a grid to help you design and position objec
3D. When this option is enabled, the grid will be displayed. Uncheck this option to hide t
grid.
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Show Markers

When text and sound markers are placed in a document, you can choose whether or no
play them. Check the Show Markers option to display markers, or leave it unchecked to
markers. There is no marker tool in Interiors, but text and sound markers can be dragge
dropped into the document. See Appendix J — Drag and Drop on page J-1 for more details

υ Textures

Use the Textures Palette to manipulate a texture applied to an object.

Select Textures from the Palettes menu to display the Textures palette:

Click on the shrink/expand button in the top right corner of the palette to extend it:

The contents of the palette will be grayed out unless an object with a texture applied to 
selected.
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When a texture is applied to an object it is scaled/stretched to fit once on each surface. T
ture can then be manipulated using the controls in the Textures palette.

Texture Palette Options

• Rotation: Enter a value between 0 and 359.9 in the rotation field and press the Retur
Enter or Tab key or use the rotation slider to adjust the degree of rotation of the text
applied to the object.

• Offset: Select Offset from the pop-up menu and the two slider bars to the right of the
up menu will relate to horizontal and vertical offset. The values for horizontal and ver
offset can be linked by clicking on the constrain box to the right of the slider bars.

Horizontal Offset: Enter a value between 0 and 1 in the Horizontal Offset field and p
the Return, Enter or Tab key or use the slider bar to move the texture across the ob
a horizontal direction.

Vertical Offset: Enter a value between 0 and 1 in the Vertical Offset field and press 
Return, Enter or Tab key or use the slider bar to move the texture across the obje
vertical direction.

• Scale: Select Scale from the pop-up menu and the two slider bars to the right of the p
menu relate to horizontal and vertical scale. The values for horizontal and vertical sc
can be linked by clicking on the constrain box at the right of the slider bars.

Horizontal Scale: Enter a value between 0 and 25 in the Horizontal Scale field and p
the Return, Enter or Tab key, or use the slider bar to change the horizontal scale 
texture on the object.
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Vertical Scale: Enter a value between 0 and 25 in the Vertical Scale field and press 
Return, Enter or Tab key or use the slider bar to change the vertical scale of the t
on the object.

• Flip Horizontal: Check the Flip Horizontal check box to flip the texture applied to the 
object around the horizontal axis.

• Flip Vertical: Check the Flip Vertical check box to flip the texture applied to the object 
around the vertical axis.

• Clamp X: Check the Clamp X check box to prevent the texture being repeated in the 
axis. The texture offset can then be adjusted to position the strip of texture on the su
D-36



-axis. 
.

. The 

 tex-

 tex-

ct a 
drag 
• Clamp Y: Check the Clamp Y check box to prevent the texture being repeated in the Y
The texture offset can then be adjusted to position the strip of texture on the surface

• If the texture is clamped in both the X and Y axes it is not repeated in either direction
texture can then be scaled and positioned on the surface as desired.

• Play Movie: This option is only available if a movie has been applied to an object as a
ture. Click on the Play Movie button to start the movie playing.

• Stop Movie: This option is only available if a movie has been applied to an object as a
ture. Click on the Stop Movie button to stop the movie playing.

• Import: Click on the Import button to display a standard dialog that allows you to sele
PICT, TIFF, JPEG, GIF, PICT clipping or movie file to import as a texture or else just 
and drop directly onto objects in the document window.
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• Sound: Use the Sound control to change the volume of the sound of any movie appli
a texture on a selected object. Click on the sound icon and a pop-up menu displays.
the level of sound required.

υ Tripod

The Tripod palette provides a way of changing the view in the current document window

Select Tripod from the Palettes menu to displays the palette:

The Tripod palette displays a graphic of a camera on a tripod. A variety of buttons provid
trols for manipulating the camera, the above dialog shows how those controls are used. I
cases click on the button to perform the relevant action. When using those buttons marke
italic text, click on the button and drag to perform the desired action.

Look At Selected

Select an object in the document and click on the Look At Selected button to position the
era to centre the selected object in its view.

Height

Step/Crab

Zoom

Pan/Tilt

Look At Selected

Zoom Out Zoom In

Adjust Height

Home View

Crab

Step

Crab

Take Picture

Pan/Tilt

Clipping
Planes
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Zoom

The Zoom controls are used to narrow or widen the focus of the camera lens

Height

The Height controls are used to change the height of the camera.

Pan/Tilt

The Pan/Tilt controls are used to change the camera’s angle by turning it left and right or 
it up and down.

Step/Crab

The Step/Crab controls are used to move the camera closer, further away, left, and right

Home View

Click on the Home View button to return the camera to its initial position (the view displa
when a new file is opened).

Take Picture

Click on the Take Picture button to save a PICT image of the window contents at 72dpi.

Clipping Planes

The Clipping Plane controls are used to adjust the camera’s front (Hither) and back (Yon
ping planes.

Although the clipping planes themselves are invisible, the effect they have on objects in 
document can be seen. The front (Hither) and back (Yon) clipping planes can be set so th
view only a section of the document. Any objects or parts of the objects closer to the cam
than the front (Hither) clipping plane, or further from the camera than the back (Yon) clip
plane, will not be visible.
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Hither Clipping

Click on the Hither Clipping button and drag up to move the front (Hither) clipping plane 
ther away from the camera or down to move the front (Hither) clipping plane towards the
era.

Yon Clipping

Click on the Yon Clipping button and drag up to move the back (Yon) clipping plane fu
away from the camera or down to move the back (Yon) clipping plane towards the came

υ Windows and Doors

The Windows and Doors palette is used to accurately position windows and doors in a w
See Windows and Doors on page G-12 for more details.

Open the Windows and Doors palette by selecting its name from the Palettes menu, and
a window or door item in the document.

• Centre in wall: Click on this button to centre a window or door in the wall. Doors will b
positioned in the centre of the length of wall but will remain on the grid, windows wil
positioned centrally in both dimensions.
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• Reverse: Click on this button to mirror a window or door about the vertical axis. Note t
this does not actually rotate the item, just changes its appearance.

• Measurements: The dimensions of the window/door, the length of the wall on either sid
the window/door and the height of the window/door above the grid displays in fields i
palette. Type in new values to change these measurements as required. When you 
a field to enter/revise values, a black arrow shows which dimension that value refers

• Length includes wall thickness: Check this check box if you wish the measurements dis
played for the length of the wall on either side of the window/door to include the thick
of the wall. This will depend on whether you are working from internal or external m
surements.

• Add snap points: Snap points are used to align and snap objects to. See Snapping Options 
on page D-12 for more details. Snap points are automatically present at the corners an
mid points of an object’s bounding box. Click on this checkbox to specify that additio
snap points should be added at the points where the window/door intersects with th
D-41
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Appendix E

Idler Plug-ins

Idler plug-ins have no interface and run constantly in the background when
loaded.
Table of Contents
Construct Idler C-4
E-1
Return to main table of contents
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υ Construct Idler

The Construct Idler has two functions:

• Performing CSG (Constructive Solid Geometry) Boolean calculations. CSG operations allow 
one geometry to cut into another — enabling you to see into a room through a windo
example. The calculation is performed each time an object with a CSG attribute is 
changed, and may take a few seconds depending on the complexity of the documen
objects must have the appropriate CSG attributes applied to them, by using a plug-in
allows CSG attributes to be applied to objects, or by using library items that already 
CSG attributes applied. Door and window library items supplied with the application,
walls drawn with the wall drawing tools, include the correct CSG attributes.

• Automatically simplifying objects as rendering speed decreases. When the Construct Idler is 
checked on in the Plug-in menu and rendering speed falls below 4 renders per seco
plug-in starts to simplify the objects in the scene that contain the most triangles, by tu
them into cubes. This allows you to continue to edit a complex document in real time,
on one of the slower computers. Any selected items, windows and doors are not affe
by this process. Items are re-drawn in full once the editing action is complete.
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Appendix F

Plug-in Tools

Individual plug-in tools are discussed in Appendix G — Plug-in Geometries
and Appendix H — Plug-in Modifiers. This appendix provides information
relevant to both types of plug-in tool.
Table of Contents

Introduction F-2

Configuring The Tools Palette F-2

Tool Options F-3
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υ Introduction

Plug-in tools are either plug-in geometries or plug-in modifiers. See Appendix G — Plug-in 
Geometries on page G-1 and Appendix H — Plug-in Modifiers on page H-1 for details o
vidual plug-ins. When loaded, plug-in tools appear in the Tools palette and can be position
the palette by the user as discussed below.

υ Configuring The Tools Palette

When Interiors is launched with all the plug-ins loaded, the plug-ins are placed in the To
palette in a default order.

The Tools palette is configurable, so you can move tools around to position them in the 
tion or group that is most convenient or logical for you.

Configure the Tools palette in the following way:

• Click on a tool and hold down the mouse button to display a pop-up menu showing 
other tools in the stack (if any). Select the name of a tool in the pop-up menu to sele
tool and bring it to the top of the stack.

• To move a tool, hold down the Command key, click on the tool and drag it to a new l
tion.

• Drop a tool onto another tool to stack them together.
F-2
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• Drop a tool onto the four selection tools at the top of the palette to separate it from a 
of stacked tools and add it to the top of the tool palette as an individual tool.

υ Tool Options

To open a dialog showing any options available for a tool, use either of the following me

• Hold down the Option key and select the tool in the Tools Palette.

• Click on the tool in the Tools palette and hold down the mouse button. Select the sam
from the pop-up menu that displays.

Note: There are no options available for the Arrow, Rotate, Rectangular Marquee and Ha
tools.
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Appendix G

Plug-in Geometries

Plug-in Geometries are plug-in tools that are used to create objects. When
installed they are located in the Tools palette.
Table of Contents

Introduction G-2

4 Walls G-3
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Point Light G-6
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Walls G-9

Windows and Doors G-12
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When loaded, Plug-in Geometries appear in the Tools palette. The position of each plug
the Tools palette will depend on how the user has configured the palette. See Configuring The 
Tools Palette on page F-2 for more details. The default arrangement is shown below.

Select the plug-in tool to use by clicking on its icon in the Tools palette.

4 Walls

Windows & Doors

Walls

Furnishings
G-2
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υ 4 Walls

The 4 Walls plug-in is used to draw a regular, four-walled room. Walls are always drawn
pendicular to the grid and resting on the grid.

1. Select the 4 Walls plug-in from the Tools palette. The view will change to show an
orthogonal, top view.

2. Click on the grid and, holding down the mouse button, drag to draw 4 walls:

3. Release the mouse button and the Edit options dialog displays:
G-3



 spec-

 at 
to-

ct the 
4. If necessary, enter values in the Width, Depth, Height and Wall thickness fields to
ify the width and depth of the room, the height of the walls and the wall thickness.

5. Click OK. The view will change back to the previous view, and the walls will display
the dimensions specified. If the walls are the first items drawn, the room will be au
matically centred on the grid.

To change the default settings for the 4 Walls plug-in, hold down the Option key and sele
4 Walls tool. The Wall Options dialog displays:

• Wall thickness: Enter a value to specify the default thickness for walls.

• Wall height: Enter a value to specify the default height for walls.
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• Internal measurement: Click on the Internal measurement radio button to specify that v
ues entered in the Entry options dialog (the dialog that displays after walls are draw
relate to the measurements of the internal walls.

• External measurement: Click on the External measurement radio button to specify that 
ues entered in the Entry options dialog (the dialog that displays after walls are draw
relate to the measurements of the external walls.

• Show info editor: Check the Show info editor check box to specify that the Entry optio
dialog should appear after walls are drawn. Uncheck this check box if you do not wa
this dialog to display.

Note: The size, position and rotation of the walls are locked on entry. If you unlock the wa
using the controls in the Info palette, the width and depth of the room, the height of the w
and the rotation of the room can be adjusted using the Info palette or the Arrow tool, but
wall thickness will be scaled proportionally. See Info Palette on page 4-17 for more informa
tion.

υ Furnishings

The Furnishings plug-in allows you to easily access furniture items to place in your docu

1. Click on the Furnishings plug-in icon in the Tools palette. The document window w
change to display a top view and the Furnishings dialog will display:

The Nudge palette will also be opened (if it is loaded) to aid in the positioning of ite
See Nudge on page D-25 for more details.
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2. Click on one of the buttons in the dialog to access furnishings of that type.

The Libraries palette is opened and the appropriate furniture library displayed — 
long as a library (or an alias) with the specified name is located in the plug-ins fol
See Libraries on page D-9 for more details.

3. Furniture items can then be dragged out of the library and dropped into the room 
required. The furniture items can be resized and positioned as necessary.

υ Point Light

Use the Point Light plug-in to place point lights in your Modeler document. Point lights rad
light in all directions.
G-6
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Note: Light objects are visible by default. If you have turned off the Show Light Markers 
option in the Lights palette, the light objects will not be displayed. See Lights on page D-20 for
more details.

Select the Point Light tool in the Tools palette and click in the document window. The lig
placed at the point clicked.

A point light is displayed as a small cube and when selected has a bounding sphere. Po
lights cannot be resized, but can be moved and rotated like other objects. Note that rota
point light will not have any affect on the lighting in the document.

Hold down the Command key when placing a point light and, if the scene is rendered us
Microspot renderer that draws shadows, that particular light will not cast any shadows.

Hold down the Option key when placing a point light and a light with a negative brightne
value will be placed in the document. The negative brightness value can be adjusted us
Brightness slider in the Info palette as usual. To adjust a light with a negative brightness
so that it has a positive brightness value, set the brightness to 0 in the Info palette, then
brightness as for an ordinary point light.

The Info Palette is used to specify the color and brightness of a selected point light. See Info 
Palette on page 4-17 for further details.

The color of the point light sphere is set in the Preferences dialog. If the color chosen is
(default) light markers take on the color of light they represent. See Preferences on page 3-5 
for further details. 

Lighting Control and Manipulation

See Lights on page D-20 for more details.

υ Spot Light

Use the Spot Light plug-in to place spot lights in your Modeler document. Spot lights ha
directional shade around them which can be rotated to direct light in a specific direction.

Note: Light objects are visible by default. If you have turned off the Show Lights option in
Lights palette, the light objects will not be displayed. See Lights on page D-20 for more 
details.
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Select the Spot Light tool in the Tools palette.

• To place a spot light at a specific position in the document: move the cursor to that point, click
and release the mouse button.

• To direct the light as you place it in the document: click on the point you wish the spot light
to shine and drag the light into position before releasing the mouse button. Hold dow
Shift key when dragging the light to constrain it to an axis perpendicular to the surfa
clicked on.

A spot light is displayed as an open, four sided pyramid with a line coming out of it. The
indicates the direction the light is pointing. When a light is selected it displays with a boun
sphere. Spot lights cannot be resized, but can be moved and rotated like other objects.

Hold down the Command key when placing a spot light and, if the scene is rendered us
Microspot renderer that draws shadows, that particular light will not cast any shadows.

Hold down the Option key when placing a spot light and a light with a negative brightnes
value will be placed in the document. The negative brightness value can be adjusted us
Brightness slider in the Info palette as usual. To adjust a light with a negative brightness
so that it has a positive brightness value, set the brightness to 0 in the Info palette, then
brightness as for an ordinary point light.

The Info Palette is used to specify the color, brightness, spread and sharpness of a selec
light. The Spread control adjusts the lens angle, while the Sharpness control adjusts the
See Info Palette on page 4-17 for further details.

The color of the spot light pyramid is set in the Preferences dialog. If the color chosen is
(default) light markers take on the color of light they represent. See Preferences on page 3-5 
for further details. 
G-8
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Lighting Control and Manipulation

See Lights on page D-16 for more details.

υ  Walls

The Walls plug-in is used to create rooms other than those with four regular walls. Walls
always drawn perpendicular to the grid and resting on the grid.

1. Select the Walls plug-in from the Tools palette. The view will change to show an 
orthogonal, top view.

2. Click in the document at the point you wish to start drawing a wall. Holding down 
mouse button, drag along one of the constrainer lines that display to draw the wa

Note: Currently only perpendicular walls can be drawn. To enter walls with internal w
measurements, draw the room in a clockwise direction as viewed from above; to 
walls with external wall measurements, enter walls in an anti-clockwise direction a
viewed from above.
G-9
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3. Click at the point you want the wall to end. The Edit options dialog displays:

• If you have drawn the wall to exactly the correct length, and the default settings fo
height and thickness of the wall are correct, click OK.

• To change any of the walls dimensions, enter new values in the Length, Height a
Wall thickness fields and click OK.

• If this is the last wall to be drawn click on the Done button.

• To enter the wall again, click the cancel button.

• To prevent this dialog from displaying, hold the Option key down when clicking o
the point you want the wall to end.

4. After closing the Edit options dialog, draw the next wall by dragging along one of 
constrainer lines displayed:
G-10
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5. Click at the point you want the wall to end. The Edit options dialog will display aga

6. Continue drawing further walls in the same way, adjusting the height and thicknes
the walls as required.

While entering walls, if the cursor is aligned with another wall corner, an alignment
will display showing the alignment, and the cursor will change to a hollow cross.

Press the delete key at any time while entering walls to delete the wall currently b
entered. The cursor will be move back to the previously entered wall.

7. When the last wall is drawn, click on the Done button in the Edit options dialog. T
view will change back to the previous view and the walls will display as specified. I
walls are the first items drawn, the room will be automatically centred on the grid.

To change the default settings for wall height and thickness for the Walls plug-in:
G-11
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1. Hold down the Option key and select the Walls tool to display the Wall Options dia

2. Enter a value in the Wall thickness field to specify the default thickness for walls.

3. Enter a value in the Wall height(s) field to specify the default height of the walls.

υ Windows and Doors

The Windows and Doors plug-in allows you to easily access window and door items to pl
your document.

1. Click on the Windows and Doors plug-in icon in the Tools palette. The document w
dow will change to display a view from the middle of the room looking towards the
G-12
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back wall. The Windows and Doors palette will be opened and the Windows and D
dialog will display:

The NaviCam palette will also display to enable you to easily change the window v
See NaviCam on page D-23 for more details.

2. Click on one of the buttons in the dialog to access that type of object.

The Libraries palette is opened and the appropriate library displayed — as long a
library (or an alias) with the specified name is located in the plug-ins folder. See Librar-
ies on page D-9 for more details.

If you click on the button marked ‘Other’ the standard Open File dialog is displaye
You can then select the file to open.
G-13
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3. Windows and doors can then be dragged out of the library and dropped onto the 
of the room. They can then be resized and positioned as required by dragging the
or by using the Windows and Doors palette. See Windows and Doors on page D-40 fo
more details.
G-14
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Appendix H

Plug-in Modifiers

Plug-in Modifiers are plug-in tools that are used to modify objects or the
scene in some way. When installed they are located in the Tools palette.
Table of Contents
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υ Introduction

 When loaded, plug-in modifiers appear in the Tools palette. The position of each plug-in 
palette will depend on how the user has configured it; the default arrangement is shown 
See Configuring The Tools Palette on page F-2 for more details.

υ Gravity

The Gravity plug-in is used to place objects on the grid.

Select the Gravity tool from the Tools palette. As the cursor is moved over the documen
dow it will change to a downward arrow. The active point is at the tip of the arrow. Click o
object and it will be moved so that its lowest point is placed on the grid.

If an object has been locked by clicking on the padlock icon in the top right corner of the
palette, or by selecting Lock from the Options menu, you will not be able to use the Gra
tool to drop the object to the grid. 

If the object position is locked only in the Y-axis, the Gravity tool will over-ride this restra
and can be used to drop the object to the grid. If you have several objects selected, som

Light Director
VR

Sun Direction
GravityScale Object

Orbit
Walkthrough View Finder
H-2
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which may be locked in the Y-axis, hold down the Shift key when using the Gravity tool to
vent these locked objects from being dropped to the grid.

See Name on page 4-17 and Lock on page 4-18 for details.

 Gravity Menu Plug-in

Make a selection in the document window and choose Gravity from the Plug-in menu. T
selected object(s) will be placed on the grid.

υ Light Director

The Light Director plug-in is used to direct one or more spot lights in a particular directio

Select the light(s) to direct, then select the Light Director tool in the Tools palette. In the 
ment window, click at the place you want the lights to point. The light(s) will be rotated to
point at the place specified.

Lights can also be selected using the Light Director tool by selecting the tool and clicking
light. Hold down the Shift key and click on additional lights to increase the selection. Hol
down the Shift key and click on a selected light to remove it from the selection.

υ  Orbit

The orbit plug-in is used to move the camera around a selected object.

Select the Orbit tool from the Tool palette. Move the cursor over the document window a
will change to a black diamond.

• Click on an object: drag the mouse left, right, up, or down and the view will orbit aroun
the center of the object’s bounding frame.

• Click on the grid: drag the mouse left, right, up, or down, and the view will orbit around 
center of the grid.
H-3
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• Click in an empty area of the document window: drag the mouse left, right, up, or down, an
the camera will orbit around the center of the grid.

In all cases, the further you move the mouse from the point where you first clicked, the f
the view will move. Use of the option key will slow this rate of movement.

υ Scale Object

The Scale plug-in is used to easily scale selected objects by percentage values.

1. Select the Scale Object tool from the Tool palette. The Scale Object dialog displa

2. To maintain an object’s proportions, ensure that the constrain checkbox to the rig
the dialog remains checked on. Enter a percentage value to scale the object by in
dimension, the percentage values for the y and z dimensions will be automatically
changed to the same value. 

3. To scale an object without maintaining its proportions, uncheck the constrain chec
Enter percentage values to scale the object in each of the x, y and z dimensions.

4. Click OK, then click on an object in the document window. It will be scaled by the 
specified value(s).
H-4
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The Scale Object Menu Command Plug-in

Make a selection in the document window and choose Scale Object from the Plug-in men
Scale Object dialog will display. Enter values in the dialog as described in steps 2 and 3
and click OK. The selected object(s) will be scaled by the specified value(s).

υ Sun Direction

The Sun Direction plug-in is used to adjust the direction the sun light shines in.

The Sun Direction plug-in has the following options, displayed by selecting the Sun Dire
plug-in with the Option key pressed.

The Option dialog box allows you to enter values for both the angle of elevation of the sun
its position angle referenced from the clockwise direction, relative to the north.

When the Sun Direction plug-in is selected, and the Auto Show Plug-in Palettes prefere
enabled, the Lights palette is automatically opened so that you can make any necessary
changes to the way the scene is lit. See Lights on page D-20 for more details.

1. Select the Sun Direction tool from the Tools palette.
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2. The document window changes to show a top view, depending on the selection in
Option dialog. The current direction the sun light is shining in is depicted as a red
with a handle at the end:

3. Click on the handle and holding down the mouse button drag to change the positi
the source of the sun light.

4. Hold down the Control key as you drag to move the position of the source of the s
light closer or further away.

5. Movement of the sun direction line can be constrained to the X, Y and Z axes by h
ing down the Shift key.

6. Release the mouse button to drop the handle at its new location.
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υ View Finder

The View Finder tool allows you to click anywhere in the document to change the camer
entation to have that point at the center of the view.

υ VR

The VR plug-in is used to pan and tilt the camera using control mechanisms similar to th
found in QuickTime™ VR.

When the VR plug-in is selected, the NaviCam palette is automatically opened so that yo
use it to make changes to the camera position and view. See NaviCam on page D-23 for more
details.

Select the VR tool from the Tools palette and click in your document window.

• To pan the camera (turn it left and right): hold down the mouse button and drag the m
left and right.

• To tilt the camera: hold down the mouse button and drag the mouse up and down. T
is limited to +/- 90°.

• To crab the camera (move it to the left or right): hold down the mouse button and the
mand key and drag the mouse left and right.

• To move the camera forwards and backwards: hold down the mouse button and the
mand key and drag the mouse up and down.

• To zoom in: hold down the Shift key.

• To zoom out: hold down the Control key.

As you move, the cursor changes to an arrow head pointing in the direction you are mov
all cases, the further you move the mouse from the point first clicked on, the faster the c
will move. Use of the option key will slow this rate of movement.

Alternatively, select the VR tool and use the arrow keys to move the camera:
H-7
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• To pan the camera (turn it left and right): use the left and right arrow keys.

• To tilt the camera: use the up and down arrow keys. The tilt is limited to +/- 90°.

• To crab the camera (move it to the left or right): hold down the Command key and us
left and right arrow keys.

• To move the camera forwards and backwards: hold down the Command key and us
up and down arrow keys.

υ Walkthrough

The Walkthrough plug-in is used to walk the camera through a scene.

Select the Walkthrough tool from the Tool palette. Click in your Modeler document windo
and the cursor will change to a black diamond. Drag the mouse to the left and right to m
those directions, or up to move forwards and down to move backwards. Use the left and
arrow keys to crab (move side to side), and the up and down arrow keys to tilt the came

As you move, the cursor changes to a black arrow head pointing in the direction you are
ing. In all cases, the further you move the mouse from the point first clicked on, the faste
camera will move.

Use of the option key will slow the rate of movement.
H-8
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Appendix I

Microspot Plug-in Renderers
Table of Contents

Introduction I-2

Selecting Microspot Renderers I-2

Renderer Options I-3
Renderer Options Dialog I-3
Shadows I-4

On/Off I-4
Resolution I-4
Soft Edges I-4

Anti-alias Image I-4
Anti-alias Image is Off I-4
Anti-alias Image is On I-4

Improving Rendering Speeds I-5
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υ Introduction

The Microspot Renderer is a plug-in renderer that provides the following features in add
to those provided by the interactive renderer: transparency; shadows; pixel level lighting 
lations; image anti-aliasing. These features allow you to render a high quality, more real
3D scene — in particular the pixel level lighting calculations give more accurate represe
tions of how lighting affects surfaces.

The Microspot Preview Renderer is a limited version of the Microspot Renderer. The 
Microspot Preview Renderer allows the fast display of a scene rendered with Shadows a
Soft edges. 

υ Selecting Microspot Renderers

The Microspot Renderer is accessed via the Renderer Options palette. Select Renderer 
from the Palettes menu to display this palette:
I-2
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Click on the Renderers pop-up menu, the Microspot Renderer and the Microspot Preview
derer will be listed beneath the Wireframe and Interactive Renderers:

Select the Microspot Renderer to render the current scene with the Microspot Renderer

υ Renderer Options

In the Renderer Options palette select the Microspot Renderer and click on the Options 
in the upper right corner of the palette or hold down the Option key when selecting the 
Microspot Renderer. 

Renderer Options Dialog

The Microspot Renderer's Options dialog will then display:

Alternatively hold the Option key down when selecting the Microspot Renderer in the Re
derer pop-up menu to display the Microspot Renderer's Options dialog. The dialog prov
controls to turn shadows on and off, adjust the resolution of the shadows, soften the edg
shadows and choose how much image anti-aliasing to apply. Click OK when you have s
rendering options to render your scene.
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Shadows

On/Off

If you turn on shadows it will increase memory usage by a significant amount and also s
down the rendering greatly. Rendering speed and memory usage are directly proportion
the number of lights in the scene. Point lights and wide spot lights (greater than a 60° an
will use 6 times as much memory as a normal narrow spot light although they will not dec
the rendering speed any more than a normal light. Any directional light will use the same
amount of memory as a norma point light. In Interiors, if you do not need the sun light, tu
off to save memory.

Resolution

Increasing the shadow resolution will not only increase your memory usage significantly
will slow down your rendering too. We recommend that you keep the slider in the middle
unless you really need sharper shadows. See Improving Rendering Speeds on page I-5 for m
details.

Soft Edges

Turning on soft edges will soften the edges of the shadows, creating a more realistic sha
effect. Selecting this option will cause no real slow down of the shadows calculations.

Anti-alias Image

Use the anti-alias image checkbox to turn anti-aliasing on or off for the image. If image a
aliasing is turned off, the whole image is rendered at the same resolution. If image anti-a
is turned on, the edges of objects in the image are softened. Select the quality of render
Good, Better and Best radio buttons, taking into account the amount of memory availab

Anti-alias Image is Off

• Good: The image will be rendered at 72 dpi. A typical 640 x 480 render will require 2
Mb of RAM as an image buffer.

• Better: The image will be rendered at 144 dpi. A typical 640 x 480 render will require 
Mb of RAM as an image buffer.

• Best: The image will be rendered at 288 dpi. A typical 640 x 480 render will require 40
of RAM as an image buffer.

Anti-alias Image is On

• Good: The image will be rendered at 72 dpi, with soft edges at 288 dpi. A typical 640
480 render will require 2.5 Mb of RAM as an image buffer.
I-4
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• Better: The image will be rendered at 72 dpi, with soft edges at 1152 dpi. A typical 64
480 render will require 2.5 Mb of RAM as an image buffer.

• Best: The image will be rendered at 144 dpi, with soft edges at 1152 dpi. A typical 64
480 render will require 10 Mb of RAM as an image buffer.

υ Improving Rendering Speeds

If rendering speeds are very slow the renderer will start to draw your image in bands. Th
not a problem in itself, it will just take a long time for the complete scene to be drawn. If 
want to try to speed rendering up, try the following: reduce the render quality or the shad
resolution. If the renderer still draws in bands, reduce the number of lights (especially po
lights) in the scene.
I-5
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Appendix J

Drag and Drop

This section discusses dragging and dropping colors, 3D objects, text, TIFF,
JPEG, GIF and Movie files to and from Interiors documents.
Table of Contents

Drag Output J-2

Copy J-3

Drag Input J-3

Notes J-4
J-1

Return to main table of contents
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DRAG OUTPUT

You can drag a color from the Window control panel, Lights Palette or Info Palette to:

• A 3D object in Interiors

• Another Lights Palette or Info Palette color or any other palette that includes color bu

• The Finder Desktop or a Folder window

• The Finder Trash Can

• An Interiors Library file

• A PICT-compatible, Drag & Drop aware application

You can drag a 3D object or an entire scene (by holding down the Option key and clickin
the background) to:

• Another view of the same file in Interiors

• The window of a different file in Interiors

• A 3DMF-compatible, Drag & Drop aware application

• A PICT-compatible, Drag & Drop aware application

• The Finder Desktop or a Folder window

• The Finder Trash Can (to delete the object)

• A Interiors Library file
J-2
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COPY

When you copy selected items from an Interiors document, the following types of data a
on the Clipboard:

• A PICT of the selected items which is the same size as the front window

• A 3DMF as a single grouped item.

DRAG INPUT

Drag a PICT file from the Finder to:

• A 3D object to create a texture of the picture wrapped around the object

• The document window to make a background picture

• The document window to make a foreground picture (hold down the Control key whe
dropping the file)

• The grid to make a rectangle with a texture of the picture

Drag a TIFF, JPEG GIF or Movie file from the Finder to:

• A 3D object to create a texture of the picture wrapped around the object.

Drag a 3DMF file from the Finder to:

• A Interiors document (to import it)
J-3
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Drag a clippings file of the following type from the Finder:

• A PICT clipping (See Drag a PICT file from the Finder)

• 3DMF clipping (See Drag a 3DMF file from the Finder)

Dragan Interiors color clipping file (created by dragging a color from a color button into t
Finder) from the Finder to:

• A 3D object to change its color

• The grid to change its color

• The background to change its color

• The window toolbar to change the default color, as well as any selected items

• The Lights Palette to change the color of the appropriate light

• The Info Palette to change the color of the selected object/light

• Any other palette that includes color button

NOTES

• To drag and drop locked items out of an Interiors document window, hold down the 
Option key.

• Holding down the Control key as you drag and drop an item onto an object or group
ungroups the object or group and places the item on just one surface of the object, 
one item in the group.

• Hold down the Option key as you drag a 3D object to leave a duplicate in the same 
as the original.
J-4



Appendix K

Plug-in Directory

Lists the application’s plug-ins by name, provides details of the plug-in’s
type and status, and offers a brief description of its use.

K

Return to main table of contents



or
y 

K

#
N

am
e

Ty
pe

U
se

 th
e 

pl
ug

-in
 to

…

1
A

lig
n

P
al

et
te

A
lig

n 
ob

je
ct

s 
in

 a
ny

 o
r 

al
l o

f t
he

 X
, Y

 a
nd

 Z
 a

xe
s.

2
A

ut
oS

av
e

M
en

u 
C

om
m

an
d

3
A

xi
s

P
al

et
te

D
is

pl
ay

 th
e 

cu
rr

en
t o

rie
nt

at
io

n 
of

 th
e 

fr
on

t w
in

do
w

’s
 c

am
er

a.

4
C

ol
or

P
al

et
te

D
is

pl
ay

 a
 c

ol
or

 p
ic

ke
r 

to
 e

as
ily

 c
ha

ng
e 

th
e 

de
fa

ul
t, 

or
 a

n 
ob

je
ct

’s
, 

co
lo

r.

5
C

ol
or

 P
al

et
te

P
al

et
te

A
 r

ep
os

ito
ry

 fo
r 

12
 c

ol
or

s.

6
C

on
st

ru
ct

 
Id

le
r

Id
le

r

7
C

ur
so

r 
O

pt
io

ns
P

al
et

te

8
G

ra
vi

ty
M

en
u 

C
om

m
an

d 
&

 
M

od
ifi

er

P
la

ce
 o

bj
ec

ts
 o

n 
th

e 
do

cu
m

en
t g

rid
.

9
Li

br
ar

ie
s

P
al

et
te

S
to

re
 a

nd
 r

et
rie

ve
 d

at
a.

 C
on

ta
in

 h
un

dr
ed

s 
of

 fu
rn

itu
re

 a
nd

 a
cc

es
s

ite
m

s.

10
Li

gh
t 

D
ire

ct
or

M
od

ifi
er

D
ire

ct
 o

ne
 o

r 
m

or
e 

sp
ot

 li
gh

ts
 to

 p
oi

nt
 in

 a
 p

ar
tic

ul
ar

 d
ire

ct
io

n.

11
Li

gh
ts

P
al

et
te

C
on

tr
ol

 th
e 

In
te

rio
rs

 li
gh

tin
g 

fe
at

ur
es

.

12
N

av
iC

am
P

al
et

te
C

on
tr

ol
 th

e 
ca

m
er

a 
po

si
tio

n 
an

d 
vi

ew
.

K-1



.  
13
N

ud
ge

P
al

et
te

M
ov

e 
or

 r
ot

at
e 

an
 o

bj
ec

t b
y 

a 
sp

ec
ifi

ed
 a

m
ou

nt
.

14
O

rb
it

M
od

ifi
er

O
rb

it 
th

e 
ca

m
er

a 
ar

ou
nd

 a
 s

el
ec

te
d 

ob
je

ct
 o

r 
po

in
t.

15
P

ic
tu

re
E

xp
or

t
S

av
e 

th
e 

do
cu

m
en

t v
ie

w
 a

s 
a 

P
IC

T,
 T

IF
F

 o
r 

JP
E

G
 im

ag
e.

16
P

oi
nt

 L
ig

ht
s

G
eo

m
et

ry
P

la
ce

 p
oi

nt
 li

gh
ts

.

17
R

en
de

re
r 

O
pt

io
ns

P
al

et
te

C
ha

ng
e 

th
e 

w
ay

 th
e 

do
cu

m
en

t a
nd

 o
bj

ec
ts

 w
ith

in
 it

 a
re

 d
is

pl
ay

ed

18
S

ca
le

 O
bj

ec
t

M
od

ifi
er

S
ca

le
 s

el
ec

te
d 

ob
je

ct
s 

by
 p

er
ce

nt
ag

e 
va

lu
es

.

19
S

po
t L

ig
ht

G
eo

m
et

ry
P

la
ce

 s
po

t l
ig

ht
s 

in
 th

e 
do

cu
m

en
t.

20
S

un
 

D
ire

ct
io

n
M

od
ifi

er
A

dj
us

t t
he

 d
ire

ct
io

n 
th

e 
su

n 
lig

ht
 s

hi
ne

s 
in

.

21
Te

xt
ur

es
P

al
et

te
Im

po
rt

 a
nd

 m
an

ip
ul

at
e 

a 
te

xt
ur

e 
ap

pl
ie

d 
to

 a
n 

ob
je

ct
 a

nd
 p

la
y 

m
ov

ie
s 

as
 te

xt
ur

es
.

22
T

rip
od

P
al

et
te

C
ha

ng
e 

th
e 

do
cu

m
en

t v
ie

w
.

23
V

R
M

od
ifi

er
P

an
 a

nd
 ti

lt 
th

e 
ca

m
er

a 
us

in
g 

co
nt

ro
l m

ec
ha

ni
sm

s 
si

m
ila

r 
to

 th
os

e
fo

un
d 

in
 Q

ui
ck

T
im

e™
 V

R
.

24
W

al
kt

hr
ou

gh
M

od
ifi

er
W

al
k 

th
e 

ca
m

er
a 

th
ro

ug
h 

a 
sc

en
e.

25
W

al
ls

G
eo

m
et

ry
C

re
at

e 
ro

om
s 

ot
he

r 
th

an
 th

os
e 

w
ith

 4
 r

eg
ul

ar
 w

al
ls

.

26
W

in
do

w
s 

&
 

D
oo

rs
P

al
et

te
 &

 
G

eo
m

et
ry

#
N

am
e

Ty
pe

U
se

 th
e 

pl
ug

-in
 to

…

K-2



L

Appendix L

Command Key Table

Command key shortcuts can be used to perform many actions. The following
table lists those key combinations.
Table of Contents

Command Key Table L-2
File Menu L-2
Edit Menu L-2
View Menu L-3
Options Menu L-3
Plug-in Menu L-3
Help Menu L-4
Others L-4
L-1
Return to main table of contents



COMMAND KEY TABLE

Action Command Key

File Menu

New Command N

Open Command O

Close Command W

Save Command S

Print Command P

Quit Command Q

Edit Menu

Undo/Redo Command Z

Undo/Redo F1

Cut Command X

Cut F2

Copy Command C

Copy F3

Paste Command V

Paste F4

Delete Whole Object Backspace

Delete Whole Object Delete

Select All Command A

Duplicate Command D

Duplicate No Offset Command Shift D

Clone Command =

Clone No Offset Command Shift =
L-2



Group Command G

Ungroup Command U

View Menu

New Window Command K

Look At Selected Command 1

Home View Command 3

Home View Home

Custom (View) Command 0

Top (View) Command 5

Front (View) Command 8

Left (View) Command 4

Right (View) Command 6

Back (View) Command 2

Last View Command 9

Last View End

Options Menu

Edit Item Command E

Lock Command L

Unlock Command Shift L

Grid Snap Command Y

Metric Command M

Inches Command I

Orbit Around View Command T

Plug-in Menu

Last Plug-in Command *

Action Command Key
L-3



Help Menu

Online Manual Help

Others

Refresh F5

Action Command Key
L-4



Index
Numerics
3D object

add to document
add to object 3 - 19
as foreground/background picture 3 -

20
as object 3 - 19

drag and drop J - 1, J - 2
3DMF

drag and drop J - 3
3DMF clipping, drag and drop J - 4
4 walls plug-in G - 3

change default settings G - 4
edit walls drawn with G - 5
options G - 3

A
add

object to selection 4 - 5
align

locked items D - 7
objects D - 7

line of alignment D - 7
alignment plug-in D - 7, 1 - 1
ambient light

adjust amount reflected by object 4 - 26
arrow keys, use to

move/rotate the grid 4 - 10
rotate object 4 - 10

arrow tool 4 - 4
autogrid 3 - 35
axis plug-in D - 7, 1 - 1

display palette D - 8
display/hide axis D - 9

extend palette D - 9

B
bounding frame 4 - 4, 4 - 7

hide 4 - 5
bounding sphere 4 - 9
brightness of light, adjust 4 - 20, 4 - 22

C
camera

adjust to change view
using navicam palette D - 23

control, using VR plug-in H - 7
display orientation D - 7
height

adjust using the navicam palette 2 -
14, D - 23

move
using navicam palette 2 - 14, D - 24

move around selected object H - 3
return to initial position 3 - 30, D - 39
step and crab

using navicam palette D - 24
tilt

using navicam palette D - 23
turn

using navicam palette D - 24
view

set to orthographic D - 28
set to perspective D - 28
walk through scene H - 8

camera plug-in
height D - 39
step/crab D - 39
tilt/turn D - 39
zoom D - 39

change
prevent 4 - 18



protect object from 3 - 34
remove protection against 3 - 34
view 3 - 29

back view 3 - 31
custom 3 - 30
front view 3 - 31
last view 3 - 31
left view 3 - 31
look at selected 3 - 30
right view 3 - 31
to home view 3 - 30
top view 3 - 31

circle
edges to a

set preference 3 - 7
clear

items or attributes without placing them
on the clipboard 3 - 21

object from a file
using drag and drop 3 - 21

close 3 - 14
all editing windows 3 - 33
current document 3 - 14
current window 3 - 26
palette 4 - 3

color
change an object’s color 4 - 31
clipping file

drag and drop J - 4
currently selected 4 - 30
default

changing using the picker palette D -
10

default color 4 - 30
change 4 - 31

drag and drop 4 - 23, 4 - 31, D - 10, J - 1,
J - 2

object 4 - 22

change 4 - 22
changing using the picker palette D -

10
reflective color

change 4 - 23
lock 4 - 23

storing in the color palette D - 10
surface 4 - 22

color picker 4 - 31, D - 10
color plug-in D - 10, 1 - 1

changing colors D - 11
display D - 10
using colors D - 10

comments
about objects 4 - 27

configuring
the tool palette H - 2

constrain
object movement 4 - 6
object proportions 4 - 8, 4 - 20
object rotation 4 - 9, 4 - 10, 4 - 20
object size 4 - 7
object to original proportions 4 - 8

copy
items J - 3
selected item from document 3 - 17
using drag and drop J - 4

crab 4 - 15
camera

using VR plug-in 2 - 49, H - 7, H - 8
crab camera

control D - 39
cut

selected item from document 3 - 17

D
default

color 4 - 30



tool 4 - 4
set preference 3 - 6

delete
saved view 3 - 27

deselect
object in selection 4 - 5

direct
lights H - 3

dismantleable
flag 4 - 18
objects 3 - 35

display
document

control using renderer options palette
D - 27

selected object in center of window 3 -
30

do undos
set preference 3 - 7

drag and drop J - 1
3D objects J - 2, J - 3
clippings file J - 4
color J - 2
copy J - 4
from 3D World J - 2
GIF J - 3
into 3D World J - 3
JPEG J - 3
locked items J - 4
movie J - 3
onto groups J - 4
PICT J - 3
textures onto objects D - 37
TIFF J - 3

draw
irregular shaped rooms G - 9
walls G - 3

duplicate

objects 3 - 22
without applying offset 3 - 23

dynamic
updates

set preference 3 - 6

E
edit

group 3 - 32, 4 - 5
edit menu 3 - 16
elevation 4 - 15
export

files from 3D World documents 3 - 12
export plug-ins 1 - 3, B - 1, B - 2
export submenu B - 2

F
flag object as primitive/dismantleable 4 - 18

G
geometry

plug-ins G - 1
GIF

drag and drop J - 1, J - 3
import as texture D - 37

global lights
set preference 3 - 7

gravity plug-in H - 2, 1 - 1
menu command H - 3

grid
moving 4 - 11
moving/rotating 4 - 10
options 3 - 36

set grid square size 3 - 36
set snapping grid distance 3 - 36
specify preferred unit size 3 - 36

place objects on H - 2
rotate D - 8



rotating 4 - 12
solid

set preference 3 - 7
group

edit 4 - 5
objects 3 - 24
select 4 - 5

grouped objects
dismantleable 3 - 25
drag and drop onto J - 4
edit 3 - 24
flag as primitive or dismantleable 3 - 33
object handles 3 - 25
primitive 3 - 25
ungroup 3 - 25

H
hand tool 4 - 4, 4 - 14
handle, object 4 - 4, 4 - 7
height, adjust camera 4 - 15, D - 39
help 1 - 4

messages 4 - 28
help palette 4 - 28

display 4 - 28
resize 4 - 28

hide
bounding frame 4 - 5

high resolution printing, set preference 3 - 6

I
idler plug-ins 1 - 3
import

file as texture, using textures plug-in D -
37

file into 3D World document 3 - 11
import plug-ins 1 - 3, A - 1
import submenu A - 2
inches, select as units of measurement 3 - 37

info palette 4 - 17
controls 4 - 17
display 4 - 17

insert file into 3D World document 3 - 9
PICT

add to object 3 - 11
as foreground/background picture 3 -

11
as object 3 - 10

QuickDraw 3D
add to object 3 - 10

installation 1 - 2

J
JPEG

drag and drop J - 1, J - 3
import

as texture D - 37

L
libraries plug-in 1 - 1
light

adjust 4 - 17, D - 21
brightness 4 - 22

direct H - 3
marker

display G - 7
point light G - 6
spot light G - 7

adjust sharpness 4 - 27
adjust spread 4 - 25

sun light
set direction H - 5

light director plug-in 1 - 1
lights

global D - 20
set preference 3 - 7

lights plug-in D - 20, 1 - 1



adjust brightness of all spot/point lights
D - 21

ambient light D - 21
adjust brightness D - 21
select color for D - 21
turn on/off D - 21

display palette D - 20
lighting controls D - 20
marker

hide D - 22
show D - 22

sunlight D - 21
adjust brightness D - 21
select color for D - 21
turn on/off D - 21

turn on/off all spot/point lights D - 21
lock

object 3 - 34, 4 - 18
object position 4 - 19
object rotation 4 - 20
object size 4 - 19
reflective color 4 - 23

locked object, drag and drop J - 4

M
menu command plug-ins 1 - 3, C - 1
menus

edit 3 - 16
file 3 - 8
options 3 - 32
palettes 3 - 38
view 3 - 26

metric, select as units of measurement 3 - 37
modifier plug-ins H - 1
move

camera
around selected object H - 3

grid 4 - 11

closer and further away 4 - 11
constrain movement 4 - 12
using arrow keys 4 - 10

object 4 - 4, 4 - 6, 4 - 7, 4 - 9
by specified amount 2 - 29, D - 25
closer or further away 4 - 6
constrain movement 4 - 6
using arrow keys 4 - 7
using info palette 4 - 18

movie file
drag and drop J - 1, J - 3
import as texture D - 37

multi walls plug-in G - 9
change default settings G - 11
display entry options G - 10
use external wall measurements G - 9
use internal wall measurements G - 9

N
name

object 4 - 17
view 3 - 27

navicam plug-in D - 23, 1 - 1
adjust camera height 2 - 14, D - 23
adjust height of camera and point of in-

terest D - 24
adjust height of point of interest D - 23
display palette D - 23
move camera 2 - 14, D - 24
move camera and point of interest D - 24
move camera or point of interest to pre-

defined positions D - 25
move point of interest 2 - 14, D - 24
zoom in/out D - 24, D - 25, D - 40

new
3D World document, open 3 - 8
window 3 - 26

nudge plug-in D - 25, 1 - 2



display palette D - 26
move object by specified amount D - 26
rotate object by specified amount D - 27

O
object

characteristics, adjust 4 - 17
flag as dismantleable 4 - 18
flag as primitive 4 - 18
information 4 - 17

on-line manual 1 - 4
access 3 - 40

open
documents, list of 3 - 31
existing document 3 - 9
new window for current document 3 - 26
palette 3 - 38, 3 - 39, 4 - 3, D - 3

options menu 3 - 32
orbit plug-in H - 3, 1 - 2
orthographic view 4 - 15

P
page setup 3 - 15

display dialog 3 - 15
palette

close 4 - 3
open 3 - 38, 3 - 39, 4 - 3, D - 3
plug-ins D - 1
standard 3 - 38
status and position 4 - 3
tabbed D - 3
tabbed palette

access D - 4
display tab menu D - 6
remove from stack D - 5
stack D - 4

palettes 4 - 1
alignment D - 7

axis D - 7
color D - 10
help 4 - 28
info 4 - 17
lights D - 20
navicam D - 23
nudge D - 25
renderer options D - 27
textures palette D - 34
tools 4 - 4
tripod D - 38

palettes menu 3 - 38, 4 - 3
pan camera 4 - 15

using VR plug-in H - 7
paste

item into document 3 - 17
from application other than 3D

World 3 - 18
paste special

add 3D object
as forground/background picture 3 -

20
as object 3 - 19
to object 3 - 19

add picture
as forground/background picture 3 -

20
as object 3 - 19
to object 3 - 20

perspective view 4 - 15
picker plug-in D - 27

display palette D - 10
PICT

drag and drop J - 3
clipping J - 4

export B - 2
import

as texture D - 37



import as texture D - 37
insert file into 3D World document 3 - 9

add to object 3 - 11
as foreground/background picture 3 -

11
as object 3 - 10

save
image of window contents as D - 39

picture
add to document

add to object 3 - 20
as foreground/background picture 3 -

20
as object 3 - 19

picture plug-in B - 2, 1 - 2
plug-in architecture 1 - 3
plug-in geometries 1 - 3, F - 2, G - 1, L - 1
plug-in idlers E - 1
plug-in modifiers 1 - 3, F - 2, H - 1, H - 2
plug-in palettes 1 - 3
plug-in tool

select G - 2
plug-in tools F - 1, F - 2

position in tools palette G - 2
plug-ins 1 - 3

directory of 1 - 1
plug-ins palettes D - 1
point light plug-in G - 6
point lights

editing G - 7
place G - 6
set object color G - 7
that don’t cast shadows G - 7
with negative brightness G - 7

point lights plug-in 1 - 2
position

lock object 4 - 19

object/light 4 - 17
of cursor 4 - 28
tools in the tools palette F - 2

preferences 3 - 5
color preferences 3 - 6

background color 3 - 6
default color 3 - 6
grid color 3 - 6
light marker color 3 - 6
locked handle color 3 - 6
object handle color 3 - 6
open handle color 3 - 6

default tool 3 - 6
do undos 3 - 7
dynamic updates 3 - 6
edges to a circle 3 - 7
global lights 3 - 7
high resolution printing 3 - 6
solid grid 3 - 7
sound on 3 - 6

prevent changes 4 - 18
primitive objects 3 - 34
print 3 - 16

display dialog 3 - 16
printing

high resolution
set preference 3 - 6

proportions
constrain object 4 - 20

Q
QuickDraw 3D

file, insert into 3D World document 3 - 9
add to object 3 - 10
as fore/background picture 3 - 11
as object 3 - 10

quit application 3 - 8



R
rectangular marquee tool 4 - 4, 4 - 13
redo action cancelled using undo command
3 - 17
reflective color

change 4 - 23
renderer options plug-in D - 27, 1 - 2

backface options
flip D - 33
remove D - 33
show D - 32

choose render
interactive D - 29

choose renderer
wire frame D - 29

choose rendering style
edges D - 30
filled D - 29
points D - 30

choose shading quality
best D - 32
plain D - 31
smooth D - 31

choose view
orthographic D - 28
perspective D - 28

display palette D - 27
further options for non-interactive ren-

derers D - 29
show grid checkbox D - 33
show markers checkbox D - 34

rendering
best shading 4 - 23, 4 - 26

resize
help palette 4 - 28
window 4 - 31

return camera to initial position 3 - 30

revert to last saved version of document 3 -
15
rotate

grid 4 - 12
constrain rotation 4 - 13
using arrow keys 4 - 10

object 4 - 9, 4 - 20
by specified amount D - 25
constrain rotation 4 - 9, 4 - 10
lock rotation 4 - 20
using arrow keys 4 - 10

view around central point 3 - 37
rotate tool 4 - 4

S
save 3 - 15

alert displays when closing document 3 -
14

current view 3 - 27
document

in 3D metafile format 3 - 15
with different name or in different lo-

cation 3 - 15
view as PICT image D - 39
view as picture 2 - 52, B - 2

save as 3 - 15
scale

object 4 - 7
scale object plug-in H - 4, 1 - 2

menu command H - 5
scale by percentage values H - 4

select
all objects in current window 3 - 21
group 4 - 5
none of objects in current window 3 - 22
object 4 - 4, 4 - 7, 4 - 9, 4 - 13

behind another 4 - 6
tool 4 - 4, G - 2



selection
add objects to 4 - 5, 4 - 14
deselect objects in 4 - 14
deselect one object in 4 - 5

sharpness
adjust for spot light 4 - 27

shininess
adjust for object 4 - 24

size
change object 4 - 7

constrain 4 - 7
constrain to original proportions 4 - 8
keep proportions 4 - 7
using info palette 4 - 19

object 4 - 19
constrain proportions 4 - 20
lock 4 - 19

snap to grid 3 - 35
solid grid, set preference 3 - 7
sound

turn on/off checkbox 3 - 6
spot light

adjust G - 8
display light object G - 7
set light object color G - 8

spot light plug-in G - 7, 1 - 2
constrain position of light G - 8
direct light as placing in document G - 8
place light in document G - 7

in specific position G - 8
that doesn’t cast shadow G - 8
with negative brightness value G - 8

spread
adjust spot light 4 - 25

step camera, using VR plug-in 2 - 49, H - 7,
H - 8
step/crab camera control D - 39
sun direction plug-in H - 5, 1 - 2

sun light
adjust direction H - 5

surface
color 4 - 22

T
technical support 1 - 4
text

add to document 3 - 9
drag and drop J - 1

texture
manipulate D - 34

textures plug-in D - 34, 1 - 2
adjust texture

offset D - 35
rotation D - 35
scale D - 35

apply movie file as texture
adjust sound volume D - 38
play movie D - 37
stop playing movie D - 37

display palette D - 34
extend palette D - 34
flip texture D - 36
import texture D - 37

TIFF
drag and drop J - 1, J - 3
import as texture D - 37

tilt camera 4 - 15, D - 39, H - 7
tool

default 4 - 4
keep selected 4 - 4
options F - 3
select 4 - 4

tools palette 4 - 3, 4 - 4
configure F - 2, H - 2

tools, plug-in tools 4 - 4
transparency



adjust 4 - 20
tripod plug-in D - 38, 1 - 2

display palette D - 38
turn camera D - 39

U
undo

do undos preference 3 - 7
last object manipulation 3 - 16

ungroup
objects 3 - 25

units of measurement
inches 3 - 37
metric 3 - 37

unlock
object 3 - 34, 4 - 18

updates, dynamic
set preference 3 - 6

V
view

change 3 - 29, 4 - 29
adjust camera height 4 - 15
move camera 4 - 15
move grid 4 - 10
tilt camera 4 - 15
turn camera 4 - 15
using hand tool 4 - 14
using navicam plug-in D - 23

using the tripod plug-in D - 38
zoom in 4 - 15, 4 - 29
zoom out 4 - 29

delete 3 - 27
display previous 3 - 31
name 3 - 27
set default standard 3 - 29
standard 3 - 31

view menu 3 - 26
VR plug-in H - 7, 1 - 2

W
walkthrough plug-in H - 8, 1 - 2
walls, draw

using 4 walls plug-in G - 3
using multi walls plug-in G - 9

window
close 3 - 26
open new 3 - 26
resize 4 - 31

window toolbar 4 - 3, 4 - 29

Z
zoom

camera control D - 39
in 4 - 15, 4 - 29
out 4 - 29
using VR plug-in 2 - 49, H - 7
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